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Disclaimer

Harris Govern has taken due care in preparing this manual. However, nothing 
contained herein modifies or alters in any way the standard terms and 
conditions of the purchase, lease, or license agreement by which the product 
was acquired, nor increases in any way the liability of Harris Govern to the 
customer.
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Introduction: Govern Real Property Tax 
Assessment & Billing

The Govern Tax Billing (Real Estate) module is designed to meet the needs of 
local government organizations when creating property tax assessments. It is 
integrated with Govern Property Control for name and address and mailing 
information; and Govern Accounts Receivable system for tax billing. Govern 
Computer Assisted Mass Appraisal (CAMA) system can be added for 
transferring property appraisal information to the tax system.

Key features include:

• Integration with other modules in the Govern system
• Creating levies and exemptions that are customized to meet the needs of 

your organization
• Creating groups to facilitate management of levies and exemptions.
• Setting limited assessment values and cap amounts for levy groups
• Setting average values 
• Averaging assessment groups
• Cap levy groups
• Creating frozen assessments in order to keep a copy of all tax data for a 

property at a specific moment
• Creating partial billings to accommodate changes within a property tax 

assessment year.
• Transferring changes to future assessment years that are already open

The Real Property module is designed to reduce the number of hours required 
to process taxes and perform the tasks of the Tax Collector and Assessor, 
such as creating and maintaining Levy and Exemption Code Definitions and 
Groups.

What’s New

This section lists the most recent features in Govern TAX 5.1 and 6.0.

Overview



Real Estate Tax 
A/R Cycle Codes for Tax

It is now mandatory to create A/R Cycle Codes for Real Property tax billing. 
You need to set up at least one Cycle Code, but you can create multiple 
codes. For example, you could have one cycle for municipal tax and a second 
for school tax.

Frozen IDs are now created for cycle billing. A new Frozen ID is assigned 
when you run the Posting to A/R batch process. This is called a Certified 
Record. It is displayed in the History Panel with the Cycle Code. The first 
Certified Record is assigned Frozen ID -1, the second -2, and if there are 
multiple cycle codes, the third is assigned -3 and so on. 

A new Tax Audit record is created for all the parcels included in the batch 
process. The Entry Code for these records is set to Original. The Frozen ID 
is updated and a new entry is listed in the History Panel. For further details, 
see Tax Audit on page 76.

Posting to A/R

In addition to generating new Frozen IDs for cycle billing, a new option is 
available on the Posting to A/R batch process for prepayments.

Select Generate Discount for Prepayments if you want to calculate and 
apply a discount to prepayments. Otherwise, the discount is calculated and 
applied to full payments only.
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Chapter 1: Administration

The Govern Tax administrative forms are used for defining the parameters 
required in the real property tax system. This setup includes integrating 
records with Govern CAMA and Accounts Receivable, adding increase / 
decrease values, defining capped values, creating and maintaining tax levies 
levy groups, tax exemptions, exemptions groups, and applying rules for 
averaging assessment values over a number of years, and setting caps for the 
levies applied to a property.

This section describes the following forms:

• A/R Cycle Codes for Tax on page 4
• General Parameters on page 7
• Tax Levy Parameters (Real Property) on page 28
• Levy Group Definition (Real Property) on page 35
• Exemption Codes on page 38
• Exemption Group Definition (Real Property) on page 44
• Averaging Assessment Values on page 47
• Cap Levy Group on page 54

Overview
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Property
A/R Cycle Codes for Tax

It is mandatory to create A/R Cycle Codes for Real Property tax billing. 
According to the requirements of your organization, you can set up one Cycle 
Code or use multiple codes. For example, you may have one A/R Cycle Code 
for school tax and another for municipal tax.

When you post the records to A/R, by running the Posting to A/R batch 
process, you need to select a cycle code. A new Frozen ID is created, the 
record is labeled Certified and displayed in the History Panel with the Cycle 
Code. 

 

The preceding screen shot shows Certified records generated for the Real 
Estate County cycle code. The records are assigned the Frozen ID -1. If a 
second tax billing were posted for a second cycle code, certified records with 
the Frozen ID -2 would be listed in the History Panel.

In order to set up cycle codes for A/R, ensure that the A/R Master by Cycle 
Code option is selected in the Accounts Receivable General Parameters in 
Govern Admin.

Overview
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A/R Cycle Codes for Tax
Then create A/R Class Codes for real property tax billing and associate the 
cycle codes to these classes. If you already have class codes for cycle billing, 
you can associate the new cycle codes to the existing class codes.

To associate cycle codes to class codes:

1. Launch Govern Admin.

2. Select Accounts Receivable > A/R Class Codes.

3. Select the A/R Class Code.
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Govern Tax: Real 
Property
4. Select the Cycle Code from the drop-down list.

5. Click Save.

For more information about setting up A/R Parameters and Class Codes, refer 
to the Accounts Receivable documentation.
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General Parameters
General Parameters

The Govern Tax General Parameters form is used for defining general or 
default options for Govern Real Property Tax. These options include 
integrating records with Govern CAMA and Accounts Receivable, general 
parameters for rounding on exemptions, the prior year rate increase / 
decrease method, and capped value defaults. 

To access this form:

1. Launch Govern New Administration (GNA).

2. Select Application Configurations > Govern Tax > Real Property > 

General Parameters.

Overview
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Govern Tax: Real 
Property
General parameters and options for transferring appraisal data from Govern 
CAMA are displayed across the top of the form. Page 1 contains the tax levy, 
prior rate increase and decrease setting, and accounts receivable parameters. 
Page 2 contains the limited assessment and new construction index defaults.

Mailing Index Security Settings

You can define the security permissions, separately, for each mailing type in 
the Real Property Tax Mailing Index. For example, you may want to give all 
users the right to modify payer and third party information, but give only 
authorized users the right to modify owner information, and only 
administrators the right to modify Managing Agent, or Mortgage Company 
information.

Mailing Types include the following, listed by code and name:

Use the following procedure to define security settings for the different mailing 
types in the Real Property Mailing Index. 

This procedure requires both the Govern Security Manager (GSM) and 
Govern New Administration (GNA). 

To set the security for the Mailing Index:

1. Launch GNA.

2. Select Editors > System Validation Table Editor.

Code Name

a Managing Agent

b Owner under Payment Plan

m Mortgage

o Owner

p Payer

r Previous Customer

t Third Party

x Temporary Owner

Tip: The same procedure can be applied to any validation table in Govern.
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General Parameters
3. Select Mailing Index Type from the list of tables on the right.

4. Select the Securable option.

5. Click the Save icon.

6. Launch the Govern Security Manager (GSM).

7. Select Synchronize All.

8. Select Applications > Validation Tables > System Validation Tables.

9. Expand the MAILTYPE system validation table.

10. Expand the codes.
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Property
11. Right click on each code for which you want to set security access rights.

12. Click Edit and update the rights as required.

13. Click Save.

For further details on the GSM, refer to the Govern Security Manager (GSM) 
documentation.

Upgrading from Govern for Windows

In Govern for Windows if the Full Access Rights for MI (Mortgage) option is 
selected on the Govern Admin Taxation General Parameters form, users with 
full access rights to the Mailing Index function have the right to modify all 
mailing index types including mortgage company information.

If this option is deselected, users with full access rights to the function have 
the permission to modify all mailing index information with the exception of 
mortgage company information.

In Govern Open Forms, this option is set with all other security options in the 
Govern Security Manager (GSM).
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General Parameters
Manual Bill Number

In Govern for Windows, there is a separate option to enable the Bill 
Sequence Number or A/R Bill Number field on the Real Estate Assessment 
Maintenance function. 

In Govern Open Forms, the security permission to show or hide this field, as 
with all other fields, can be performed in the GSM. For further details on the 
GSM, refer to the Govern Security Manager (GSM) guide.

Command Buttons

The Govern Tax General Parameters from includes the following command 
buttons.

Save: Click Save to save a new Taxation General Parameters setup or 
modifications to an existing one.

Exit: Click Exit to close the form.
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Property
Parameters

The parameters at the top of the Govern Tax General Parameters include the 
general defaults for rounding exemptions, and rolling data forward, as well as 
options for transferring records from CAMA.

Round Up Exemptions: Govern Real Property Tax Billing & Collection 
options are rounded up. The default value is 1. This rounds exemptions up to 
the nearest dollar. Enter a different value for rounding up the exemption if 
required.

Do Not Copy Expired Exemptions to Next Year: Select this option if 
you want to exclude the expired tax exemptions from the update when you 
copy the tax parameters to the next fiscal year.

Display Assessment Increase / Decrease: Select this option to display 
the Assessment Increase or Decrease on the Real Estate Assessment 
Maintenance form in Govern. Deselect it to hide this value.

Prevent Tax Code Duplication: Select this option to perform a validation 
when you create new tax codes. If a code with the same name already exists, 
a message is displayed. 

Assessment Generated by Mass Appraisal: Select this option to use 
the assessment data calculated through the Govern CAMA subsytem

Roll Forward Data: Select the Roll Forward Data option if you plan to 
make modifications in earlier years and carry them forward to records in the 
future years that are open.

When making property assessments, you may have open the current fiscal 
year and several years in the future. For example, if the current fiscal year is 
2014, you may have open 2014, 2015, 2016, and 2017. The configuration 
parameters and property records from 2012 are copied to the future years, 
2013, 2014, and 2015.

For example, if 10 is entered in this field, exemption amounts between 
$11.00 and $20.00 are rounded up to $20.00. Amounts between $21.00 
and $30.00 are rounded up to $40.00, and so on.

Note: Values from Govern CAMA cannot be modified on the Tax 
Assessment Maintenance form.
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General Parameters
If there is a change made in 2014; for example an extension to a porch, you 
can update the record for the year in which the change occurred and then roll 
the change forward to the future years, without having to open and modify 
each record. The changed field is copied from the current year to the future 
years. Structures that have not changed are not rolled forward.

A confirmation message, similar to the following, appears each time you save 
a new record or modify an existing one. 

When the confirmation record appears, do one of the following:

• Click Yes to roll the current modification forward.
Newly created records, deleted records, and modified records are rolled 
forward.

• Click No if you do not want to roll the current modification forward.

The following table lists the data that are rolled forward:

Note: The data are rolled forward if the Govern Tax Assessment record 
exists for the current parcel.  
 
Typically, this record would be created when you open the new year. 
However, if it were deleted, the Roll Forward would not occur.

Govern Forms Govern Tables

Property Area PC_AREA

Legal Information PC_LEGAL_INFO

Tax Real Estate Assessment TX_RE_ASSESSMENT

Tax Assessment AC_, BT_, PP_, MV_, 
RE_ASSESSMENT

Tax Exemptions TX_EXEMPTIONS

Tax Levy Master TX_LEVY_MASTER
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Govern Tax: Real 
Property
The Roll Forward Data option can be set on the Govern CAMA and on all 
Govern Tax General Parameters forms. Only the modification is carried 
forward. Calculations are performed immediately, and changes can be viewed 
on the records for all open years, at the same time.

If the Roll Forward option is selected, you can view the Roll Forward Data 
process, as follows:

1. Launch Govern.

2. Open a Profile that includes Tax Assessment.

3. Perform a search and load a property record that has records from 
multiple years.

4. Select the History divider.

5. Select a record from a year prior to the current year.

A yellow dot appears on the interface beside the icons to indicate that the 
record is in historical mode. The Frozen ID of the record is also displayed 
on the interface.

6. Make a change to the record.

7. Save the record.

The Roll Forward Data message appears:

Appraisal Property Information

Appraisal data

MA_MASTER

Building Drawing MA_DRAWING 

Building Area MA_BLDG_AREA

Building Structural Elements MA_BUILDINGS, MA_BUILDINGS_2, 
MA_BUILDINGS_3, etc.

Income MA_INCOME

Land MA_LAND

MRA MA_MRA

Site Information MA_SITE

Miscellaneous Structures MA_MISC_STRUCTURES

Govern Forms Govern Tables
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General Parameters
.

Roll Forward and Frozen Records

Frozen Records can be thought of as snapshots of property records. You can 
open a Frozen Record and view the data in all the user forms as they were 
when they were frozen. New modifications are saved to the current record. 
The purpose of the frozen record is to preserve of a copy of the data. Typically, 
you would not need to make changes to the frozen record. However, you can 
set up security to give authorized users the right to modify frozen data. 

To define access rights for alternate security:

1. Launch the Govern OpenForms Designer (OFD). 

2. Open the Real Property Tax form.

3. Click the Security icon .
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Property
4. Select Alternative under Type.

5. Select the Profile.

6. Select the role or user.

7. Click Save.

Refer to the OpenForms Designer for further details on setting up security for 
forms.

Taxation General Parameters Page 1

Page 1 has three sections for setting tax parameters, tax levy, prior year 
increase and decrease setting, and accounts receivable settings.
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General Parameters
Tax General Parameters: Tax Levies

Consolidated Rate Type: Select the rate type (by hundred, thousand, or 
unit). The consolidated tax rate is displayed on the Real Property Assessment 
Maintenance form in Govern.

Even Inst. on Levy Type: This field is enabled if Even Installment is 
selected from the Force Installment drop-down list in the Accounts 
Receivable section of this form. 

If the field is enabled, you can select a specific levy type from the drop-down 
list (Table: VT_USR_ LEVYTYPE). Otherwise, you can leave this field blank to 
apply even installments to all levy types. The levy types are optional 
categories that can be assigned to each levy on the Tax Levy Parameters 
form. See Tax Levy Parameters (Real Property) on page 28. Exemptions can 
also be assigned to levy types. See Exemption Codes on page 38.

Note: This value is displayed if all previous taxes were computed with the 
Base x Rate type and applied on the same Base Column.
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Property
Prorata Tax Levy Code: Select a Levy Code for prorating the exemption, 
from the drop-down list. For example, if an exemption is removed half way 
through the year, the billing is pro rated by the equivalent of six months in the 
following fiscal year, on the selected Levy Code.

Period Ending on: This field is enabled if you select a levy from the Prorata 
Tax Levy Code drop-down list. Double-click in the field and select the ending 
date from the pop-up calendar. 

Prior Year Rate Increase / Decrease

The options in this section are used in the tax levy computation. The following 
screen shots show how the last year increase or decrease is calculated and 
displayed on the Tax Levy Parameters form under Computation Information 
> Last Year. For further details on configuring tax levies, see Tax Levy 
Parameters (Real Property) on page 28.
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General Parameters
Amount

Percentage

If Amount and Manual are both 
selected, you can enter an amount. 
The dollar sign is displayed beside 
the field.

If Amount is selected and Manual 
is deselected, the increase or 
decrease is automatically displayed 
in dollars and cents. The dollar sign 
is displayed beside the field.

If Percentage and Manual are both 
selected, you can enter a 
percentage. The percentage sign is 
displayed beside the field.

If Percentage is selected and 
Manual is deselected, the prior year 
increase/decrease is automatically 
displayed as a percentage. The 
percentage sign is displayed beside 
the field.
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Property
Accounts Receivable Information

No. of Installments: Enter the number of installments to be used during the 
billing process to a maximum of 12.

Force Installment: Select the installment type from the drop-down list. If 
you select Even Installment, the Even installment on Levy Type field in the 
Tax Levies section is enabled. You can select a specific levy type for even 
installments or apply even installments to all levy types.

Check Digit for Bill Numbers: This option is not intended for regular 
sequencing. Select this option to use a check digit on your next billing. This is 
a single digit that is generated by the system and used for error detection. It 
could be used, for example, to ensure that a new bill number does not already 
exist.

Use Estimated Tax: Select this option to use the Estimated Tax method to 
calculate the net taxes due. In this method, payments are based on the values 
from the previous fiscal year. Typically, this is used for quarterly installment 
billing, as follows:

• For the first and second installments, the net Ad Valorem tax from the 
previous year is divided by two and this amount is divided equally over the 
two payments.

• For the third and fourth installments, the payments are calculated 
according to the following formula:

Note: If the amount cannot be divided equally, a penny can be added to one 
or more installments. For example, if you divide a bill across four 
installments and have three cents left over, you can add a penny to the 
fourth installment.

Assessed Value * New Tax Rate = Total Amount Due
Total Amount Due – (Installment 1 + 2) / 2 = (Installment 3 and 4)
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General Parameters
The estimated tax process can also be set up for biannual installment billing, 
where

• The first payment covers the first and second installment.
• The second payment covers the third and fourth payments.

After you post bills using the Estimated Billing method, the difference 
between the estimated and actual amount is displayed as an adjustment on 
the A/R Inquiry detail grid. 

Transfer A/R to Tax Title: Select this option to transfer the A/R data posted 
for the Real Property A/R Class Code to the Tax Title A/R Class Code, during 
the Tentative Tax Title Transfer batch process. Otherwise, the options for the 
A/R Class Codes do not appear on the on the batch processing form. Refer to 
the Tax Title guide for further details.

Minimum Amount to Bill: Enter the minimum amount to be billed. The 
minimum is used if the total for the levies is less than this amount.

Minimum Amount Before Installment: Enter the minimum amount 
required before a tax bill can be divided into installments.

Fiscal Starting Date: If you have selected the Apportionments / 
Consolidations in Current Year option, enter the day and month that the 
current fiscal year begins. If you leave this field blank, the current fiscal year 
begins on the first of January.

When you create an apportionment, consolidation or partial billing in Govern, 
the year is equal to the fiscal year of the department, as entered on the Profile 
Editor form in GNA.

If, for example, $100.00, is the minimum, and the client owes only 
$50.00, a single bill is issued. If the client owes $101.00, i.e. more than 
the minimum amount, this amount is divided into installments and billed 
accordingly.
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Creating a Partial Billing in the Current Fiscal 
Year

This section provides an overview of the Partial Billing process for the current 
fiscal or open year. It includes the administrative setup, required user data 
entry forms, and batch process, as well as a description of the Internal 
Process.

Administrative Setup

1. In Govern Admin, select Parameters > Tax Billing > Real Property > 
General Parameters to launch the Taxation General Parameters form.

2. Select Apportionments / Consolidations in Current Year.

3. Enter the day and month that the current fiscal year begins in the Fiscal 
Starting Date field. Otherwise, the default, January 1, is used.

4. Click Save.

User Data Entry

1. In Govern, launch the Tax Assessment Maintenance function for the 
applicable property record.

2. Enter the starting date of the partial billing period in the Effective Date 
field and click Save.

3. Record the change for which you are creating the partial billing; for 
example, an additional tax levy or exemption or a property split / merge.

4. Create an audit record. Open the Real Estate Tax Audit Information form. 
Enter the required data and click Save.

Note: The partial billing covers the period from the effective date until the 
end of the current fiscal year. The end of the current fiscal year is 
12 months after the Fiscal Starting Date entered on the Taxation 
General Parameters form, in Govern Admin, or December 31st, if 
this field is left blank.

Note: You need to enter the change and update all associated data, 
before creating the partial billing record.
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5. Select the Partial Billing option and Reason Code.

For more information, see Real Estate Assessment Maintenance on page 65.

Batch Processing

Run the batch process, as described on Partial Billing Posting on page 127.

Internal Process

The Partial Billing process generates partial billing records, in the following 
sequence:

A partial billing is generated for all properties with a frozen ID.

If the Not Subject to Partial Billing option is selected on the Tax Assessment 
Maintenance function, the property is not added to the partial billing posting.

If a single Frozen ID is associated with a property, the partial billing is made 
from the Effective Date, entered on the Tax Assessment Maintenance 
function, to the end of the current fiscal year.

If multiple frozen IDs are associated with a property, multiple partial billings are 
generated. Partial Billings are made according to the effective dates entered 
for the frozen assessment records, and are processed chronologically, by 
date, regardless of the frozen ID, as follows:

The first billing is made for the frozen record with the earliest effective date. It 
covers the period from this date to the day before the next effective date. The 
billings continue until the record with the most recent effective date is reached. 
This billing is made from the effective date to the end of the current fiscal year. 

In the following example, three frozen IDs are associated with a property 
record. The fiscal year ends on December 31.

Note: You need a frozen record, before you can create a partial billing 
record. 
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Three partial billings are created as follows

Taxation General Parameters Page 2

Real Property Taxation General Parameters Page 2 displays options for 
setting default Limited Assessment and New Construction increase values.

Frozen ID Effective Date

-2 January 1

-3 June 16

-4 October 1

Billing # Frozen ID Effective Dates

00000001 -2 January 1 - May 31

00000002 -3 June 1 - September 30

00000003 -4 October 1 - December 31
Page 24 © 2015 Govern



General Parameters
Limited Assessment is a method used to define capped values for property 
assessments. These are applied in order to prevent an abrupt increase in 
taxes in a year that appraisals or tax assessments have increased 
significantly. The limited assessment can be applied through the Govern 
CAMA Limited Assessment Validation Table and Codes. These validation 
codes are applied by jurisdiction, neighborhood, property type, and appraisal 
method. Alternatively, you can define defaults for the Limited Assessment on 
the parameters on this page. 

The Real Property Taxation defaults are applied under the following 
conditions:

• You are not using Govern CAMA.
• A Limited Assessment Validation Code for the selected jurisdiction, 

neighborhood, property type, and appraisal method does not exist.
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Limited Assessment in Govern CAMA and Tax

Limited Assessment or Capped Values create an upper limit for increasing an 
assessment in the selected year. You can set both a percentage and an 
amount.

To calculate the Capped Value for a property, the Capped Value Percentage is 
applied on the Total Assessment Value from the previous year. Next, this value 
is compared with the Capped Value Amount and the greater of the two values 
is used as the Capped Value.

For example, in 2011, the Stevens’ home was appraised at $100,000.00. In 
2012, their home is reappraised and capped values are introduced. For 
residential properties in their neighborhood, the Capped Value Percentage is 
10% and the Capped Value Amount is $8,000.00. Since the percentage value 
is greater ($10,000.00 vs. $8,000.00) the Capped Value on their home is 
$10,000.00.

The Capped Value is, in turn, used to calculate the Limited Assessment for the 
property. This is displayed on the Tax Assessment Maintenance function in 
Govern, when the appraisal information is transferred to the Real Property Tax 
sub-system.

For example, the Stevens’ home is appraised at $100,000.00 in 2011. In 2012, 
they add a garage at the cost of $20,000.00, and due to a sharp increase in 
property values, their home is appraised at $150,000.00. To prevent an 
equally sharp increase in property taxes, a limited assessment value is used.

In Govern CAMA, the Limited Assessment is calculated, according to the 
mass appraisal method and the assessment year.

Using the CAMA appraisal method:

Limited Assessment = (Total Assessment Value for the previous year) 
+ (Capped Value (Capped Value = Capped Value Amount or 
Percentage, whichever is greater)) + (Net Physical Increase (Physical 
Increase - Physical Decrease)

Note: If the Net Physical Increase is negative, it is not calculated.
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Real Property Taxation Limited Assessment Parameters

Capped Amount: Enter a default for the maximum amount that added to a 
property assessment for the year.

Capped %: Enter a default for the maximum amount that added to a property 
assessment for the year. 

New Construction %: Enter a default for the maximum physical increase 
that can be applied to a property assessment for the year.
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Tax Levy Parameters (Real Property)

The Tax Levy Parameters (Real Property) form is used for creating and 
maintaining tax levies. The setup includes defining the computation methods, 
rate types, and amounts. After creating tax levies, you need to create Levy 
Groups using the Levy Group Parameters (Real Property) form. The user 
adds levies to the tax Maintenance records as a group. See Levy Group 
Definition (Real Property) on page 35.

To access this form:

1. Launch GNA.

2. Select Application Configuration > Govern Tax > Real Property > Levy 
Codes.

Overview
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Tax Levy Command Buttons

Creating a Levy Code: To create a new levy code, click the New icon and 
enter the required information. The Exit button switches to the Cancel icon so 
that you can delete new information without closing the form.

Saving a Levy Code: Click the Save icon to save a new levy record or 
modifications to an existing one. 

Deleting a Levy Code: Click the Delete icon to remove a levy code. A 
confirmation message is displayed. Click Yes to continue.

Exit: Click the Exit icon to close the form. A confirmation message is 
displayed if there are any unsaved modifications. Click Yes to save your 
modifications. Click No to close the form without saving the new information or 
Cancel to return to the Tax Levy Parameters form.

Tax Levy Parameters

Year: Tax Levy Groups are saved by year. By default, this field displays the 
current year of the computer on which GNA is installed. To change the year, 
enter a new year in the field and click [Enter] on your keyboard.

Levy Code: Enter the Levy Code to be used with this record.

Alternate Code: Enter an alternate code to identify the record. Typically, this 
is used for reports. You could use this field for a regional or state code.

Click the drop-down arrow beside the Levy Name field to display all the short 
and long description fields.
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Enter a name for the levy code.

Short Description: Enter a description to be used for fast data entry and 
look-ups if space is limited on forms.

Long Description: This description will be displayed for look-ups, on forms 
and normally used for reporting. 

A/R Class: Select the A/R Class Code from the drop-down list (Table: 
VT_USR_AR_CLASS). This list displays the A/R Class Codes created for the 
Govern Tax Real Property subsystem. For further details on A/R Class Codes, 
refer to the Accounts Receivable guide.

Levy Type: If required, select the Levy Type from the drop-down list (Table: 
VT_USR_ LEVYTYPE). A levy type is an optional category that can be used 
for grouping levies. It can be used for reports. You can apply exemptions to 
levy types. See Exemption Codes on page 38. You can apply levies to levy 
types. See Tax Levy Parameters (Real Property) on page 28. You can also 
apply even installments by levy type. See Even Inst. on Levy Type on page 17.

Bill Sort Order: Enter the sorting order to be used when printing Govern Tax 
Real Property bills. This is a numeric field.

Computation Method: Select one of the following methods according to 
how you want to compute the levy:

• Base X Rate: for the billing process. 
• Fixed Rate: for special charges and fees. 
• Override: for one-time tax definitions, such as interest and variable 

adjustments, such as abatements. These are deleted from the master file 
during the end-of-year process. See Compute Levy and Exemption on 
page 95.

Rate Type: Select a Rate Type only if the selected computation method is 
Base x Rate.

Note: If you enter a name for levy code in the name field and click Save, the 
short and long description fields are automatically populated.
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Computation Information

Amount: Do one of the following, depending on the Computation Method 
selected:

• For Base x Rate, enter an amount.
• For Fixed Rate, enter a rate.
• For Override, the field is disabled. The value is entered on the data entry 

form in Govern.

Last year + / - ($,%): This field is used for the increase or decrease from 
the previous year. It can display an amount or percentage and this value can 
be calculated and displayed automatically or entered manually. See Prior Year 
Rate Increase / Decrease on page 18.

Minimum Levy Amount: Enter the minimum credit amount to be 
calculated in this optional field.

Maximum Levy Amount: Enter the maximum amount for a levy if required. 
This is an optional field; leave it blank to accept unlimited levy amounts.

If the amount levied is greater than the maximum, this value is displayed in the 
Total Net Tax field on the Tax Assessment Maintenance form.

If a negative value is entered and the amount levied generates a credit greater 
than the allowed maximum, the value entered in this field is displayed as a 
negative amount in the Total Net Tax field on the Tax Levy Maintenance 
function.

Base Column: If the computation method is Base x Rate, do one of the 
following:

• Select a column from the Base Column drop-down list. This column will 
be used in the calculation of the Base for the selected Levy Code. 

• Leave this field blank to use the default Total Assessment Value 
(VA_TOTAL_ASSMT) in the calculation.

Note: This parameter accepts a negative value; so that you can generate a 
credit on tax bills. If you are entering a negative value, enter the 
number that will generate the maximum credit.

Note: This field is enabled for the Base x Rate Computation Method only.
© 2015 Govern Page 31



Govern Tax: Real 
Property
Creating a New Base Column

You can also create a new column for the calculation of the levy. In order to 
populate the new field, you can link it to a calculated field in the Business 
Entity Designer.

To create a new Base Column for the computation:

1. Click the button. This opens the New Database Fields Creation form for 
the TX_RE_ASSESSMENT table. 

2. The new column name begins with the prefix VA and the underscore 
character (_). Enter a maximum of eight additional characters.

3. Enter a description for the column.

4. Select a column type from the drop-down list:
• Currency
• Date/Time
• Memo Field
• Numeric no decimals
• Numeric with decimals
• Text (alphanumeric)

5. Click Save.

This procedure adds the field to TX_RE_ASSESSMENT table in the 
database. If you are linking this field to a calculated field, a logical expression, 
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or formula, you need to open the Govern Business Entity Designer (BED), 
create the link, and assign properties, such as linking it to a logical expression 
or formula. 

To assign properties to the new field:

1. Launch the BED.

2. Open Business Entities in the Model Explorer.

3. Select the Tax Assessment entity.

4. Verify the following properties under Data Mapping Settings:
• Data Mapping Type: Relational Database
• Datasource: Select the name of the datasource you are configuring. 
• Table: TX_RE_ASSESSMENT
• Column: Select the column you created in GNA.
• Identity Type: None

5. Click Calculated from the Predefined Content field to link the new 
column to an expression.

6. Select Expression from the Expression Type field.
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7. Click inside the Expression value field to open the Expression Editor and 
create your expression.

8. Click Save.
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Levy Group Definition (Real Property)

The Levy Group Definition (Govern Tax) form is used for grouping together a 
number of tax levies. The purpose of this is to facilitate data entry on the 
Govern Tax: Real Property Estate Assessment form. When the user selects a 
levy group on the Tax Maintenance form, a new record is created for each levy 
in the group on the Tax Levies form.

To access this Levy Group Definition form:

1. Launch GNA.

2. Select Application Configurations > Govern Tax > Real Property > 
Levy Groups.

Overview
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Tax Levies: The Tax Levies list box displays all the real property tax levies 
(Table: VT_USR_ LEVYCODE) configured for the year that is entered.

To view the levies that are part of a group, select the group on the left. The 
check boxes for the levies that are part of the group are selected.

Viewing Levy Group Definitions: The Tax Levy Groups for the selected 
year are listed on the left. 

Saving a Levy Group: Click the Save icon to save a new Levy Group or 
any modifications made to an existing one. A prompt is displayed asking you 
to confirm if you are updating multiple records:

Deleting a Levy Group: Click the Delete icon to remove a Levy Group. A 
confirmation message is displayed. 

Click OK to continue or Cancel to return to the Levy Group Definition form.

Exit: Click Exit to close the form. A confirmation message is displayed if there 
are any unsaved modifications. Click Yes to save your modifications. Click No 
to close the form without saving the new information or Cancel to return to the 
Tax Levy Group Definition form.

Tax Levy Group Definition Parameters

Year: Tax Levy Groups are saved by year. By default, this field displays the 
current year of the computer on which GNA is installed. To change the year, 
enter a new year in the field and click [Enter] on your keyboard.

Creating a New Levy Group: To create a new tax levy group:

1. Enter the code for group at the top of the form.
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2. Click the drop-down arrow to the left of the Name text box to display the 
French and English Long and Short Description fields.

3. Enter a name for the group and the required descriptions.

4. Click the Save icon.

The Levy Group name is displayed in the Levy Group drop-down list on the 
Govern Tax: Real Property Assessment form in Govern. See Tax Assessment 
on page 48.

Adding a Levy to a Group: To add a levy to a group, select the check box 
beside the levy in the Tax Levies list box and click Save. 

Removing a Levy from a Group: To remove a levy from a group, 
deselect the check box beside it and click Save. 

Deleting a Levy Group: Click the Delete icon to delete a levy group. A 
confirmation message appears. A confirmation message appears. 

Click OK to continue.

Note: If you enter a name for levy group in the name field and click Save, the 
short and long description fields are automatically populated.
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Exemption Codes

The Tax Exemption Parameters (Govern Tax) form is used for creating and 
maintaining exemptions on real property tax. This form provides options for 
setting up and applying levies in multiple ways.

The exemptions created on this form can be applied to the following:

• The entire tax assessment.
• A levy applied to the tax assessment
• A Govern CAMA land, building, income, or miscellaneous structures 

record. Refer to the Govern CAMA guide for details.
• As part of a group defined on the Exemption Groups form. See Exemption 

Group Definition (Real Property) on page 44 for details.

Exemptions can also be applied to a name record associated with multiple tax 
accounts: real property, personal property, motor vehicle, boat, and aircraft 
and applied by priority. 

Accessing the Exemption Codes Form

To access this form:

1. Launch GNA.

2. Select Application Configurations > Govern Tax > Real Property > 
Exemption Codes.

Overview
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Tax Exemption Command Buttons

Creating an Exemption Code: To create a new exemption code, click the 
New icon and enter the required information. The Exit icon switches to 
Cancel so that you can delete new information without closing the form.

Saving an Exemption Code: Click the Save icon to save a new 
exemption code or modifications to an existing one. 

Deleting an Exemption Code: Click the Delete icon to remove a levy 
code. A confirmation message is displayed. Click OK to continue or Cancel to 
return to the Tax Exemption Parameters form.

Exit: Click the Exit icon to close the form. A confirmation message is 
displayed if there are any unsaved modifications. Click Yes to save your 
modifications. Click No to close the form without saving the new information or 
Cancel to return to the Tax Exemption Parameters form.
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Tax Exemption Parameters

Year: Tax Exemptions are saved by year. By default, this field displays the 
current fiscal year of the computer where GNA is installed. To change the 
year, enter a new year in the field and click [Enter] on your keyboard.

Viewing Exemption Codes: All real property tax exemptions created for 
the year displayed in the Year field are listed on the left.

To view the parameters for a specific exemption code, select the exemption on 
the left.

To view an exemption created in a different year, change the year.

Exemption Code: Enter the exemption code name.

Exemption Name and Descriptions: Click the arrow to the left of the 
exemption name to view all the description fields.

The short description is used for fast data entry and look-ups, if space is 
limited on forms. The long description gives a more detailed definition. This 
can be on forms with more space and on reports.

County Exemption Code: Enter a code to a maximum of 15 characters in 
this optional field. Typically, this is used for reports.

State Exemption Code: Enter a code to a maximum of 15 characters in 
this optional field. Typically, this is used for reports. 

Tip: If you are creating a new exemption, enter the name and click Save. 
The short and long description fields are automatically populated.
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Report Group By: Enter a name for the report group to a maximum of 15 
characters in this optional field. 

Jurisdiction: You can apply the exemption by jurisdiction if you are using 
jurisdictions in your organization. This field is enabled if Support of Multiple 
Jurisdictions is selected on the System Registry Maintenance form in 
Govern Admin. Select the jurisdiction from the drop-down list (Table: VT_ 
USR_JURISD).

Exemption by: There are three ways of applying the exemption, by Amount, 
Percentage, or by a Frozen Assessment:

• Amount: Select this option if you are entering a flat value for the 
exemption.

• Frozen Assessment: You can freeze a property assessment or a portion 
of it, for an eligible taxpayer, such as a veteran, so that taxes do not 
increase. The frozen assessment amount is entered on the Tax 
Exemptions form in Govern. 
Select this option to apply the exemption by Frozen Assessment. If 
selected, the exemption is equal to the property assessment amount 
minus the frozen amount. For example, if the assessment is valued at 
$100,000, and you freeze $80,000 (by entering this value in Govern), the 
exemption is worth $20,000. 
For the Frozen Assessment method, the following fields are disabled 
Exemption Applicable (before and after computation), Value, Limit 
Amount, and Priority.

• Percentage: Select this option if you are applying the exemption as a 
percentage of the assessed value.

Exemption Applicable: Select one of the following options:

• After Computation: Select this option to apply the exemption to the net 
tax. This is the Total Taxes displayed on the Tax Assessment Maintenance 
form.

• Before Computation: Select this option to apply the exemption to the 
selected Base Column. See  Base Column on page 42.

Value: Enter the Amount or Percentage to apply to the exemption. 

Limit Amount: This option is enabled only if Percentage is selected as the 
Exemption By type. Enter the maximum amount for the exemption.
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If this field is left blank and the exemption is defined as Before Computation, 
the maximum assessment is used. If the exemption is defined as After 
Computation, the net tax is used. 

Priority (for Computation): This option is used to specify the order in 
which the exemptions are calculated. The higher the number, the higher the 
priority; for example, four is calculated before three.

Apply on Property: Select this option if you want the exemption to be 
applied on property, rather than to the name.

Non-Cumulative Exemption: By default, an exemption is cumulative; i.e., 
after a first exemption is applied, the second exemption is applied to the 
remaining amount. Select Non-cumulative Exemption to apply the 
exemption to the original amount.

Base Column: Select the Base Column to be used for the exemption. If this 
field is left blank, the Total Assessment Value, VA_TOTAL_ASSMT is the 
default.

Creating a Base Column: To create a new base column for the exemption, 
follow the procedure described for the levy. See Base Column on page 31

Clause Sort: If you are using the Abatement Management function in the 
Accounts Receivable guide and the selected exemption can be used as an 
abatement, select the Clause Sort number form the drop-down list. This 
number is referenced by the forms used for abatement applications. Refer to 
the Accounts Receivable guide for details.

Note: For entirely exempt properties such as churches, properties owned by 
charitable group, government property, etc., it is suggested that you 
create an exemption code such as wholly exempt defined as a 
percentage of 100% applied before computation, for these properties. 
Most state exemptions are primarily a reduction in assessment before 
computation. For those states where exemptions are a reduction in 
taxes due, such as in Massachusetts, it may be preferable to enter 
exemptions as abatements in the Accounts Receivable system.

Note: This option is available only if Exemptions By Percentage or Frozen 
Assessment is selected.
Page 42 © 2015 Govern



Exemption Codes
Apply to Levy Type: Levy types are an optional category used for 
managing tax levies.They are also used for applying the even installment and 
can be used for reports. See Even Inst. on Levy Type on page 17.

You can apply an exemption to a levy type for the even installment calculation 
or as an optional category.

You can also apply a levy to a levy type. See Tax Levy Parameters (Real 
Property) on page 28. 

Removing a Levy Type from the Exemption Code: Deselect the tax 
levy in the list box that you want to remove and click the Save icon.
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Exemption Group Definition (Real 
Property)

The Exemption Group Definition (Govern Tax) form is used for setting up and 
maintaining groups of tax exemptions. When completing a Tax Maintenance 
form, the user adds exemptions by group, rather than adding them one by 
one. A separate record is created for each exemption on the Exemptions form.

To access this form:

1. Launch GNA.

2. Select Parameters > Tax Billing > Real Property > Exemption Groups.

Overview
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Exemption Group Definitions Command Buttons

Viewing Exemption Groups: The Exemption Groups created for the 
displayed year are listed on the left. Select the exemption group that you want 
to view. To view the groups created for a different year, change the year.

Creating an Exemption Group: To create a new Exemption Group, click 
the New icon and enter the required information. The Exit icon switches to 
Cancel so that you can delete new information without closing the form.

Saving an Exemption Group: Click the Save icon to save a new 
Exemption Group or modifications to an existing one. 

Deleting an Exemption Group: Click the Delete icon to delete an 
Exemption Group. A confirmation message is displayed. Click OK to continue 
or Cancel to return to the form without deleting any information.

Exit: Click Exit to close the form. A confirmation message is displayed if there 
are any unsaved modifications. Click Yes to save your modifications. Click No 
to close the form without saving the new information or Cancel to return to the 
Levy Definition form.

Exemption Group Definition Parameters

Year:  Exemption Groups are saved by year. By default, this field displays the 
current fiscal year of the computer where GNA is installed. To change the 
year, enter a new year in the field and click [Enter] on your keyboard.

Exemption Group: Enter a code for the Exemption Group. This identifies 
the group in the database.

Exemption Group Name and Descriptions: Click the arrow to the left of 
the exemption group name to view all the description fields.
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The short description is used for fast data entry and look-ups, if space is 
limited on forms. The long description gives a more detailed definition. This 
can be on forms with more space and on reports.

Jurisdiction: You can set up exemption groups by jurisdiction, if Support of 
Multiple Jurisdictions is selected on the System Registry Maintenance form 
in Govern Admin. Select the jurisdiction to apply to the exemption from the 
drop-down list (Table: VT_USR_JURISD).

Exemptions: All the exemptions created for the year are listed in the list box.

• Select the exemptions that you want to add (Table: VT_USR_EXEMPT). 
• Deselect the exemptions that you want to remove. 

Tip: If you are creating a new exemption group, enter the name and click 
Save. The short and long description fields are automatically populated.
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Averaging Assessment Values

The Averaging Assessment Values form is used to spread assessment values 
over a number of years. This can be useful in preventing an abrupt increase in 
property taxes in a year when property assessment values have increased 
significantly.

For example, a property is appraised at $100,000 in 2011. Then, it is 
appraised at $175,000. in 2012. You could use the Averaging Assessment 
Values form to average the $75,000 increase over three years. Only $25,000 
is added to the assessment each year. The values are calculated when you 
run the Mass Appraisal Value Computation batch process. 

To access the Averaging Assessment Values form:

1. Launch GNA:

2. Select Application Configurations > Govern Tax > Averaging Assmt. 
Values.

Overview

Note: You can save one Averaging Assessment Values record per year.
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Averaging Assessment Values Command 
Buttons

Creating a Record: To create a new record, click the New icon and enter 
the required information. The Exit button changes to Cancel; so that you can 
remove new information without closing the form.

Saving a Record: Click the Save icon to save a new record or any 
modifications made to an existing one. 

Deleting a Record: Click the Delete icon. A confirmation message is 
displayed. Click OK to continue or Cancel to return to the form.

Exit: Click the Exit icon to close the form.

Averaging Assessment Values Parameters

Year:  Exemption Groups are saved by year. By default, this field displays the 
current fiscal year of the computer where GNA is installed. To change the 
year, enter a new year in the field and click [Enter] on your keyboard.

From Year: Enter the starting year for calculating the assessment values 
average. 

Number of Years: Enter the number of years over which you want to 
average assessment values. 
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Scenario: Averaging Assessment Values

This scenario provides the procedure for Averaging Assessment Values. 

The following table shows the difference in the appraisal value transferred to 
tax when Averaging Assessment Values is used and when it is not.

Required Administrative Setup

In order to complete the administrative setup, you need to set parameters on 
both the Taxation General Parameters and the Mass Appraisal General 
Parameters forms setup in Govern Admin.

To complete the Real Property tax parameters setup:

1. Launch GNA.

2. Select Application Configurations > Govern Tax > Real Property > 
General Parameters.

With 
Averaging Assessment Values

Without 
Averaging Assessment Values

Year Appraisal
Amount 
Transferred 
to Tax

Year Appraisal
Amount 
Transferred 
to Tax

2011 100,000 100,000 2011 100,000 100,000

2012 175,000 125,000 2012 175,000 175,000

2013 175,000 150,000 2013 175,000 175,000

2014 175,000 175,000 2014 175,000 175,000
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3. Ensure that the Assmt. Generated by Mass Appraisal option is selected.

4. Save and exit the form.

To complete the Mass Appraisal parameters setup in Govern Admin

1. Select Parameters > Mass Appraisal > General Parameters.
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2. Ensure that the Automatically Transfer to Tax option is selected.

3. Save and close the form.

Transferring the Appraised Values to Tax

When you run the process to transfer the appraised values to tax, ensure that 
the Transfer to Tax Assessment option is selected. 

To transfer the tax through a batch process;

1. Launch Govern Batch Processing.

2. Select Mass Appraisal > Appraised Values Computation.
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3. Ensure that Transfer to Tax Assessment is selected.

4. Click Start when you are ready to run the process.

Viewing the Assessment Values

After you run the Mass Appraisal Values computation, the appraised value 
transferred to Tax is displayed in the Total Assessment field.

To view the total assessment value:

1. Launch Govern.

2. Open a Profile that includes Real Property Tax.

3. Open the Tax Assessment Maintenance form.

4. Perform a search and select a parcel.
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Cap Levy Group

The Cap Levy Group form is used to set a maximum amount on specific levies 
applied to a property. For example, you could apply a cap or maximum value 
to the amount levied for special interest projects.

To do this, create a cap levy group of special interest levies and set a cap 
amount for these levies. The amount levied from levies in this group cannot 
exceed this cap. If, for example, two or three levies from the group are applied 
to a property and the total amount from those levies is greater than the cap 
amount, the cap amount is applied.

You can calculate the total amount using either a proportional or priority 
method.

To access the Cap Levy Group form:

1. Launch GNA.

2. Select Parameters > Tax Billing > Cap Levy Group.

Overview
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Cap Levy Group Icons

Viewing Records: The Cap Levy Groups created for the displayed fiscal 
year are listed on the left. 

Creating a Cap Levy Group: To create a new group, click the New icon 
and enter the required information. The Exit button switches to Cancel; so 
that you can remove new information without closing the form.

Saving a Record: Click the Save icon to save a new record or any 
modifications made to an existing one (Table: TX_PARM_TAX_CAP_LV).

Deleting a Record: Click the Delete icon to remove a cap levy group. A 
confirmation message is displayed. 
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Click OK to continue or Cancel to return to the form.

Exit: Click Exit to close the form.

Cap Levy Group Parameters

Year:  Cap Levy Groups are saved by year. By default, this field displays the 
current fiscal year of the computer where GNA is installed. To change the 
year, enter a new year in the field and click [Enter] on your keyboard.

Levy Group: Enter a code for the levy group. This is used to identify the 
group in the database.

Cap Levy Group Name and Descriptions: Click the arrow to the left of 
the levy group name to view all the description fields.

The short description is used for fast data entry and look-ups, if space is 
limited on forms. The long description gives a more detailed definition. This 
can be on forms with more space and on reports.

Amount Cap: Enter the maximum amount for the selected levies. The total 
amount of the selected levies cannot be greater that the Cap Amount when 
the levies in the Levy Group are applied to a property.

Apply Method: Select Proportional or Priority according to how you want to 
distribute the cap amount.

• Proportional: Select this option to distribute the cap amount according to 
the value of each levy. Levies with a higher value have a greater 
proportion of the cap amount.

Note: These levy groups are not the same as the levy groups created on the 
Levy Group Definition form. The purpose is only to select levies for 
applying the cap.

Tip: If you are creating a new exemption group, enter the name and click 
Save. The short and long description fields are automatically populated.
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• Priority: Select this option to distribute the cap amount in the order that 
the levies appear in the list box. 
When you select this option, the Move Up and Move Down buttons 
appear. Use these buttons to sort the levies by priority, as required.

Scenario: Two Methods for Applying Cap Amounts from 
the Cap Levy Group Form

The following scenario illustrates how the Priority and Proportional distribution 
methods are applied:

• Cap Amount: $500.00
• Levy A: $400.00
• Levy B: $300.00
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Chapter 2:  Govern Tax Assessment 

The Govern Tax Assessment data entry form is used for setting up and 
maintaining real property tax assessment information. Govern Tax data can be 
transferred from Govern CAMA, converted from another system, or entered 
manually. 

By default, Tax Assessment includes the following user forms:

• Tax Assessment: provides general information about the real property 
assessment, comparison with the prior year, and physical and equalization 
increase or decrease information. See Tax Assessment on page 64.

• History: displays the Browsing screen where you can view a list of the tax 
assessment records for all years for the current property. See History on 
page 74.

• Tax Audit: maintains tax audit records for the property. This includes 
partial billing information. See Tax Audit on page 76. 

• Tax Levies: maintains the tax levies associated with the selected property. 
When you select a levy group on the Tax Assessment form a separate 
record is created for each levy in the group and added to the Tax Levy tab. 
You can modify these records if you have the required security 
permissions. You can also add new levies. See Govern Tax Levies on 
page 80.

• Exemptions Linked to a Levy: for applying tax exemptions directly to the 
selected levy rather than to the overall assessment. See Link Exemptions 
to Levies on page 84. 

• Tax Exemptions: for linking exemptions to the assessment record. See 
Govern Tax Exemptions on page 86.

• Tax Mailing Index: for adding mailing status and forwarding information 
as well as configuring general mailing details. See Tax Mailing Index on 
page 90.

Overview
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Frozen IDs

Frozen IDs are used for identifying the following types of records current, 
historical, sales, and frozen records. 

Current Records

The Current Record in each year is identified by Frozen ID 0. This is the 
default record that appears when you are not in historical or frozen mode. 
Typically, this is the record that you access to make modifications or updates, 
and deletions. 

Historical Records

Historical records are created when you run the Finalize Assessment Roll 
batch process. These records are assigned the Frozen ID -1. The purpose of 
the historical records is to preserve a copy of the data as they were when the 
year was closed or the tax assessment roll was finalized.

Historical records are identified on the History Panel by Closed / Certified and 
the Frozen ID -1.

Sales Records

Frozen sales records are created in Govern CAMA when you create a sales 
record. This record is positive. The first time a sales record is created in a 
year, it is assigned the Frozen ID 1. This ID increments by 1 each time there is 
a sale within the year.

Frozen Records

Frozen records are created for Govern CAMA and Tax Audit records. When 
you select the Value Finalized option on the Tax Audit record, for example, all 
the active tax records for the property are automatically frozen. A negative 
Frozen ID, starting with -2, is assigned and all tax data for the property are 
preserved as they were at that moment the record was frozen. Frozen records 
are similar to snapshots. You can continue to work in the record, and then go 

Overview
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back and view the frozen data for all tax records including all levies, 
exemptions, etc. as they were when the record was frozen. 

You can continue to work in a record after it is frozen. You can also create 
multiple frozen records for a property. A new Frozen ID is assigned each time 
the record is frozen.

Frozen IDs also vary according to whether the record is frozen from CAMA 
Sales or from the audit record. The following table lists the Frozen IDs as well 
as other assigned IDs:

Understanding Security Permissions for Frozen 
Records

Security permissions for Frozen records are defined in the Govern Security 
Manager (GSM) under the Alternate Security Type. 

Typically most users would have the right to view Frozen records, but not to 
modify or delete them. An administrator could be given the right to modify a 
frozen record.

For further information, refer to the Govern Security Manager (GSM) guide. 

Viewing Frozen Records
The Frozen ID appears in the following places on the Govern UI:

• Frozen ID field of the Tax and CAMA Audit forms
• The tab for the Profile

Record Status  Frozen and Other Assigned IDs

Current Record 0

Sales Record 1, 2, 3, 4...

Certified Record for Cycle 
Billing

-1, -2, -3, -4, -5...

Simulation Data 32,767

Split / Merge Data 32,766 and lower; e.g. 32,765, 32,764, 32,763...

The Split Merged IDs are displayed in the 
Simulation field in the database table.
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• The Home menu on the Govern Ribbon 

History Panel

The History Panel lists the property records for all years, and all Frozen IDs. 
Frozen IDs are identified by Data Type. These are Current, Certified, Sales, 
and Audit. Check boxes are included to indicate whether a record exists for 
CAMA and Tax.

To view the History Panel:

1. Launch Govern.

2. Open a Profile.

3. Open a form.

4. Load property records that have Govern CAMA or Tax data.

5. Click History in the side panel to expand the panel.

If the tab is not displayed, click View > History in the Govern Ribbon.
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From the History Panel, you can view data for all the tax records for any 
Frozen ID and any year.

To view the tax records for a Frozen ID:

1. Launch Govern.

2. Open a Profile that includes Govern Tax.

3. Open the forms that you want to view.

4. Load the property records that you want to view.

5. Open the History Panel.

6. Select the record for the year and Frozen ID that you want to view.

7. Do one of the following:
• Double-click on the record.
• Select the Set Year and Frozen ID icon.

The following information is displayed on the Govern UI.
• A yellow dot appears beside the icons on the form to indicate that you 

are in Historical mode.
• The Year and Frozen ID are displayed beside the Profile tab.
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• The Year and Frozen ID are displayed in the Fiscal Year and Frozen ID 
fields on the Govern Ribbon.

To return to the Default Year of the Profile and Current Record:

1. Click the Reset Profile Year icon .

The following information is displayed on the Govern UI.
• The yellow dot is removed.
• The Default Year of the Profile and current Frozen ID are displayed 

beside the Profile tab.
• The Year and Frozen ID are displayed in the Fiscal Year and Frozen 

ID fields on the Govern Ribbon.
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Tax Assessment

The Tax Assessment form has three tabs:

• Assessment for recording general levy and assessment information: See 
page 65.

• Additional Information for viewing consolidated tax rates and values for 
the current year and assessment values from the previous year, mixed use 
and Increase/Decrease information. See page 69.

• Exemption Groups for adding a predefined group of exemptions to the 
tax assessment. See page 72.

To access this form:

1. Open a Profile that includes Real Property Tax.

2. Select the Tax Assessment form in the Forms Explorer.

Open the Assessment tab. By default, this is the first tab that appears 
when you open the form.

Overview
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Real Property Tax Assessment Icons

This section describes the icons displayed across the top of the Tax 
Assessment form.

New: Click the New icon  to enable the parameters on the form and create 
a new record. 

Cancel: The New icon changes to Cancel ; so that you cancel a record 
before you click Save.

Save: Click Save  to save a new record or modifications to an existing 
one.

Delete: Click the Delete icon  to delete a record. A confirmation message 
appears. Click Yes to continue.

Copy to Next Year: Click Copy to Next Year  to copy the selected tax 
assessment record to the following year. A confirmation message appears. 
Click OK to continue.

You can copy the Tax Assessment record for the current property using this 
procedure or copy multiple records through the batch process. 

Create New A/R: Click Create New A/R  to create a new A/R ID if one 
does not already exist for the current year for the property. This can be useful 
for managing pre-paid real property transactions.

Tax Assessment: Assessment Tab

This section describes the data entry fields on the Tax Assessment form.

Levy Group: Levy Groups are created in GNA (Table: VT_ USR_ TXCODE). 
They are used to facilitate data entry. When you add a levy group to a tax 
assessment, a separate levy record is automatically added to the Tax Levies 
tab for each levy in the group. You can view and modify these records. You 
can also add other levies individually.

Note: You can create only one tax assessment record per year for each 
property.
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For example, you could have a group of levies for residential properties in a 
neighborhood. Add this group to the assessment. Then, open the Tax Levies 
tab and delete any levies that are not applicable to the selected property or 
make modifications to the records as required. 

Assessment Reason: This field is used when there is a change to a tax 
assessment. Select the reason for the change from the dropdown list. The 
reasons for an assessment change are user-defined, but could include a 
property split / merge or consolidation (Table: VT_USR_ ASREASON).

Effective Date: Like the Assessment Reason, this parameter is useful when 
property assessments change during an assessment year. Click the Calendar 
icon and select the date and time that the new assessment becomes effective. 

The assessment reason and effective date are required for creating a Partial 
Billing record. 

Creating a Reassessment: If a property reassessment is required for the 
current year or for a previous year:

1. Open the tax assessment record. 

2. Click the calendar and select the date that the reassessment becomes 
effective from the Effective Date drop-down list.

Taxes are prorated according to the Effective Date.

3. Select a reason for the reassessment from the Assessment Reason 
drop-down list. 

Creating a Tax Assessment Record after a Split / Merge: After you 
create and finalize a Split / Merge record, you can use the following procedure 
to update the tax assessment records for the original property and for the 
newly created properties.
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To update the tax assessment records:

1. Launch Govern.

2. Open a Profile that includes Real Property Tax.

3. Open the Tax Assessment form.

4. Perform a search and load the tax record for the original property to the 
TreeView.

5. Select the date that the new assessment becomes effective or that it 
became effective in the Effective Date field.

6. Click Save.

7. Open one of the newly created parcels.

8. Repeat steps 5 and 6 on this parcel. 

9. Repeat steps 7 and 8 on all parcels.

Taxes for the Partial Billing are calculated as follows:

• Up to the effective date for the original parcel 
• Starting from the effective date for the newly created parcels.

Subject to Tax Deferral: Select this option to include the current record in 
the Tax Deferral Transfer batch process. See Tax Deferral Transfer Batch 
Process on page 152.

Not Subject to Partial Billing: Select this option to exclude the current 
record when you perform a Partial Billing Posting batch process: See Partial 
Billing Posting on page 143.

Not Subject to Tax Title / Lien: Select this option to exclude the current 
record from tax title or lien process. Refer to the Govern Tax Title guide for 
details.
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Total Land, Agricultural Credit, and Improvement Values: If you are 
automatically transferring values from CAMA, values are displayed in the 
following fields:

If values are not automatically displayed, you can enter them manually.

Total Assessment: This field displays the Total Assessment Value. This 
value is calculated differently according to the following conditions:

• If you are manually entering values

• If you are transferring assessment values from Govern CAMA

• If you are using Capped Values:

Minimum Base Value: Enter an amount for the minimum Total Assessment 
value after exemptions are applied.

Tax Field CAMA Field Reference

Total Land Value Total Land Value from 
the MA Land 
Information form.

Govern CAMA Land 
guide

Land Agricultural Credit Total Agricultural Value 
from the MA Land 
Information forms

Govern CAMA Land 
guide

Total Improvement Value Total of the Building 
and Miscellaneous 
Structures values

Govern CAMA 
Buildings guide and 
Govern CAMA: 
Miscellaneous 
Structure guide

Total Assessment Value = (Land Value) + (Land Agricultural Credit) + 
(Improvement Value)

Total Assessment Value = Appraised Value
The Appraised Value is calculated according to the Appraisal Method 
selected for the property.

Total Assessment Value = Limited Assessment Value, if the Limited 
Assessment Value is less than the Minimum Taxable Value. See 
Limited Assessment on page 69
Page 68 © 2015 MS Govern



Tax Assessment
Limited Assessment Override: Select this option to override the Limited 
Assessment value. Then, enter a value in the Limited Assessment field.

Limited Assessment: The Limited Assessment, or Capped Values, 
method is used to prevent an abrupt increase in property taxes in a year in 
which property values increase significantly. The Limited Assessment value 
replaces the Total Assessment value if it is lower than the Minimum Taxable 
Value. For further details, refer to the Limited Assessment section of the 
CAMA: General Information guide.

This field displays the Limited Assessment value under the following 
conditions:

• Govern CAMA values are transferred to Tax.
This requires the CAMA setup in GNA.

• Capped values are used to calculate the assessment value.
• One of the following is true: A capped value validation code exists for the 

appraisal method, property type, and neighborhood defined for the 
property or a default capped value is defined for all properties. 

• The Limited Assessment value is lower than the Total Assessment value.

The Limited Assessment value can be overridden.

A/R Bill Number: Enter a bill number in this field.

Notes: This field provides space for notes and comments.

Tax Assessment: Additional Information Tab

This section describes the data entry fields on the Additional Information 
tab. This tab is used for viewing or updating the Tax Summary Information. 
This tab includes the following sections:

• Tax Summary Information on page 70
• Prior Year Information on page 71
• Equalization and Physical Increase / Decrease Values on page 71
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Tax Summary Information

Consolidated Tax Rate: This field is displayed if all previous taxes were 
computed with the Base x Rate type and applied on the same Base Column.

True Tax: This field displays the total tax due before exemptions and 
charges.

Total Non-Exempt: This field displays the total of all levies from the Tax 
Levy function as well as all possible charges.

Total Net Exemptions: This field displays the total of all exemptions 
calculated in the Levy function.

Total Net Taxes: This value is calculated as follows:

Estimated Taxes: This field displays a value if the Use Estimated Tax 
option is selected on the GNA Taxation General Parameters form.

Note: Total Net Taxes = (Non-Exempt) – (Total Net Exemptions) 
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The estimated tax process calculates the net taxes due based on the previous 
year’s values. 

If the client receives quarterly billings, the first two estimated quarters are 
based on the first half of the previous year’s net Ad Valorem actual tax. This 
amount is distributed equally between the first and second quarter billing. The 
third and fourth quarter billing are based on the new tax rate. The actual tax is 
calculated as follows: 

Prior Year Information

Land Value, Land Agricultural Credit, Improvement Value, Total 
Assessment, and Last Year Taxes: Enter the values if they are not 
automatically displayed.

Equalization and Physical Increase / Decrease Values

Equalization Values are transferred from Govern CAMA if the following 
conditions are true:

• Automatically Transfer to Tax is selected on the Mass Appraisal General 
parameters form in GNA.

• The Assessment Generated by Mass Appraisal option is selected on the 
Taxation Generation Parameters form in GNA.

These values are transferred when the Mass Appraisal Values Computation 
batch process is run and the Compute Equalization Values option is 
selected.

Equalization Increase / Decrease: These values are defined in Govern 
CAMA when there is a change to the rate. They are used to bring assessed 
values to a common level.

Assessed Value * New Tax Rate = Total Amount Due
(Total Amount Due) – First Half Payment / 2 = 3rd and 4th Payments Due 

Note: The estimated tax process can also be set up for clients with two 
billings instead of four.
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Physical Increase / Decrease: Like the equalization increase / decrease, 
these values are defined in CAMA. Typically, the increase is applied to new 
buildings and structures or to improvements made on existing buildings and 
miscellaneous structures. The decrease is applied to buildings that have 
undergone damage from fire, flood, etc. 

These fields are filled, if the CAMA appraisal method is selected.

Exemption Groups

Exemptions can be applied to a tax assessment in a number of ways:

• To the entire property tax assessment
• To a CAMA land, building, miscellaneous structure, or income record 
• To an individual levy
• In a group
• Individually

This tab is used for applying an Exemption Group. The Exemption Groups are 
defined in GNA and are used to facilitate data entry. When you add an 
Exemption Group to the tax assessment, a separate Tax Exemption record is 
added for each exemption in the group. These can be viewed, updated, or 
deleted from the Tax Exemptions tab.  You can also add other exemptions 
from this tab. See Govern Tax Exemptions on page 86.

To add an Exemption Group to a tax assessment record:

1. Launch Govern.

2. Open the Real Property Tax form.

3. Perform a search and load a tax record.

4. Select the Exemption Group tab.

5. Click the Add icon .

Note: If these values are entered manually, the Equalization and Physical 
Increases and Decreases are calculated and added to the Prior Year 
Total Assessment value, as displayed on the Additional 
Information tab. These values are used in the calculation of the Total 
Assessment value for the current year.
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All exemption groups that are not already added to the assessment are 
displayed in the list box.

6. Select the group or groups of exemptions that you want to apply to the 
assessment.

7. Click Add.

When you add an exemption group, a new Tax Exemptions record is created 
for each exemption in the group.

For example, if you have a exemption group that has two exemptions, two 
new tax exemption records are created for the property and added to the Tax 
Exemptions divider. You can modify or delete the exemption in that tab. See  
Govern Tax Exemptions on page 86.
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History

The Tax Assessment History tab displays a listing of the previous records for 
the current property with details. 

You can also view records from previous years in the History panel. See  
History Panel on page 61.

To access the Tax Assessment History form:

1. Open a Profile that includes Real Property Tax.

2. Select the Tax Assessment form in the Forms Explorer.

3. Select the History tab.

By default, the grid shows all the columns in the Real Property Tax 
Assessment table, TX_RE_ASSESSMENT. You can change the default to 
display the parameters that are most relevant to your organization. For 
example, you may want to display the following:

Assessment Year: This parameter displays the year that the tax 
assessment was made. Typically, there is one tax assessment per year for 
each property. However, if the History for Current Year parameter is selected 
on the Taxation General Parameters form in GNA, frozen records can be 
created for the current year. 

Overview
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Frozen records are automatically created when a tax audit record is finalized.

Frozen ID: A Frozen ID is assigned to a certified record, which is created in 
the Posting to A/R batch process. For the first closed cycle, -1 is created, -2 
for the second cycle that is billed in a year, -3 for the third, and so on.

Total Land Value: This is the total land value from Govern CAMA Land 
Information.

Total Land Agricultural: This is the total land value for agricultural 
properties from Govern CAMA Land Information.

Total Improvement: This is the total building value from Govern CAMA 
Building Information.

Total Assessment: This is the total assessment value calculated after all 
levies and exemptions are applied.

The History tab displays all the Tax Assessment records created for the 
property from all years and all Frozen IDs. 
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Tax Audit

The Govern Tax Audit form is used for maintaining records on property audits. 
When there is a change to a tax assessment during an assessment year, you 
can record any changes made to the assessment or billing information, the 
activity code, the date and person who made the change. The assessment 
data is frozen, so that it is always possible to view or compare the data prior to 
the change.

When you run the Posting to A/R batch record, a new Tax Audit record is 
automatically creared. The Entry Code for these records is set to Original and 
the Activity Code is set to Completed. The Frozen ID is updated to -1 for the 
first record, -2 for the second, and so on.

If you have more than one Cycle Code, for example, a new Tax Audit is 
created for  

To access the Tax Assessment History form:

1. Open a Profile that includes Real Property Tax.

2. Select the Tax Assessment form in the Forms Explorer.

3. Use the arrows to scroll to the Tax Audit tab.

Overview
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Tax Audit Fields

This section describes the data entry fields on the Tax Audit form.

Year ID: This field displays the default fiscal year for the department.

Frozen ID: The default 0 is displayed in the Frozen ID field when the record 
is current and active. When you select the Value Finalized option, a Frozen 
ID is automatically assigned. The first time the record is frozen, the Frozen ID 
-2 is assigned. The IDs decrease by one each time the record is frozen: -3, -4, 
-5 and so on. 

Entry Date: Click on the Calendar icon and select the date and time of the 
Tax Audit from the pop-up calendar.

Entry Code: Select the reason for the audit from the Entry Code drop-down 
list. The Entry Code list is user-defined. Examples include court order, small 
claim or resolution (Table: VT_USR_TXENTRY).
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When you run the Posting  to A/R  batch process, a new audit record  is 
created for all selected parcels. The Entry code for the A/R record is 
automatically set to Original.

It is recommended not to select Original, when you create a Tax Audit record 
manually.

Activity Code: Select an activity code, from the drop-down list, to identify 
the activity that caused the assessment change and the reason for the audit. 
These activities are used defined. Examples include apportionment and 
consolidation (Table: VT_ USR_TXACTV).

Source Code: Select the audit information source code from the drop-down 
list. This list is user-defined. Examples include tape or manual (Table: VT_ 
USR_TXINFSRC).

Value Finalized: Select the Value Finalized option when all the information 
on the form is completed and saved. When you select this option a Frozen ID 
is assigned to the record. You cannot make further changes to the record, 
once the Value Finalized option is selected.

Partial Billing: Select this option if you are creating a partial billing for the 
selected record. Selecting it enables the Partial Billing Reason Code drop-
down list.

Posted Date: This field is automatically filled when you run the Partial Billing 
batch process.

Partial Billing Reason Code: Select a reason for the partial billing from 
the drop-down list. The reasons are user-defined. Examples include 
Apportionment From, Apportionment To, and Consolidation (Table: VT_USR_ 
PRTBL).

Notes: This field provides space for notes and comments. By default, a spell 
check is enabled for this field 

Barcode: The Barcode text box displays the AR ID and Cycle for the tax 
assessment record.   

Note: A partial billing record is not created if the Not Subject to Partial 
Billing option is selected on the Tax Assessment divider.
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If your organization uses A/R Cycles for Real Property Tax, multiple IDs are 
displayed in the drop-down list. 

Select the AR ID and the cycle code applicable to the record.

If your organization is not using Cycle Codes, the Barcode text box displays 
the AR ID for the record and connot be modified from the Tax Audit form.
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Govern Tax Levies

The Tax Levies form is used for maintaining the tax levies associated with a 
real property record. Tax levies are applied on the property tax assessment. 
They are based on property type, such as commercial or residential, and 
property value. The computation methods and information are defined for 
each levy in GNA. Exemptions can be applied to the tax levies. The final 
calculated amount is applied on the tax assessment. 

The Tax Levies form can be used in a number of ways. 

• Adding a new tax levy: You can add a new levy to a tax assessment. The 
values are automatically calculated and displayed, based on the rates 
configured in GNA, when you click the Save icon.

• Adding a group of tax levies: When you add a Levy Group to a Tax 
Assessment form, a new Tax Levy record is created for each levy in the 
group. For example, if you add the Special Assessment Levy Group to a 
property record, a new Tax Levy record is created for each of the three 
levies in this group. In this case, these are: Sewer Betterment, Street 
Betterment, and Sidewalk Betterment. Using the Tax Levy form, you can 
view the calculated amounts for each levy, modify values if you have the 
security permissions, or delete a levy record that is not required. For more 
information, see Levy Group on page 65.

• Applying exemptions on tax levies: Tax exemptions can be applied to 
the entire tax assessment for the property or by individual levy. 
• Tax exemptions added to the entire property tax assessment can be 

viewed and updated from the tax exemptions tab. See Govern Tax 
Exemptions on page 86.

• Tax exemptions applied to an individual levy can be viewed from a 
secondary window available from the Link Exemptions to a Levy tab. 
See Link Exemptions to Levies on page 84.

This section of the guide describes:

• Accessing the Tax Levies Form on page 81
• Tax Levies Icons on page 83
• Tax Levies Fields on page 81
• Link Exemptions to Levies on page 84
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Accessing the Tax Levies Form

Prerequisite: The Tax Assessment record needs to be created before you 
create a levy record. See Tax Assessment on page 64.

To access the Tax Levies form:

1. Launch Govern.

2. Open a Profile that includes Real Property Tax.

3. Select the Tax Assessment form in the Forms Explorer.

4. Use the arrows to scroll to the Tax Levies tab.

Tax Levies Fields

This section describes the data entry fields on the Tax Levies form.

Levy No.: This field displays the code or short description of the levy. 
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It is populated in two ways:

• Automatically: When you add a Levy Group to the Tax Assessment form, a 
separate levy record is added for each levy in the group. See 

• Manually: If you are adding a new levy, select the levy from the drop-down 
list. Then, click Save. The values are automatically calculated based on 
the setup in GNA, as described in this section. 

Rate / Fixed Value Override: Select this option to override the amount or 
value displayed in the Rate /  Amount Value field.

Rate / Amount Value: By default, this field displays the rate or fixed amount 
for the levy, as defined in GNA. It is calculated as defined in GNA.

To override this amount, select the Override option and enter the new rate or 
amount.

Taxation Base

Base Value Override: Select the Base Value Override option to modify the 
amount of the Base Value.

Base Value: The Base Value is equal to the total of all levies applied to the 
assessment:

Split District Override: Select the Override option to override the Split 
District percentage.

Split District: The Split District percentage is used if you are splitting the 
levy amount between two or more levies.

To split the levy amount:

1. Select the Split District Override option.

2. Enter the percentage of the total split amount that is owed on the selected 
levy.

3. Open the levy record or records for the other levies over which the amount 
is split and enter the percentage for each one.

Net Value = Base Value - Levy Value
Net Tax Amount = Net Value * Rate
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4. Click Save to calculate the amount.

Base Exemption Value: This field displays the total value of all exemptions 
applied to the current levy code.

Net Base Value: This field displays the difference between the Taxation 
Base amount and the Exemption Value:

Net Tax

Tax Amount: This field displays one of the following, according to the setup 
on the Tax Levy Parameters form in GNA for the current levy:

• Net Amount 
• Maximum Levy Amount 

It is calculated as follows:

Exemption on Net: Exemptions can be applied to the tax assessment 
before or after computation. If an exemption is applied After Computation, it is 
applied to the Total Assessment value. 

If you it is applied Before computation, it can be applied to any column in the 
Tax Assessment table. The amount is displayed in this field.

Percentage of Total: This field displays the percentage of the total levy 
amount represented by the selected levy. For example, if you have two levies, 
one might be worth 60% and the other 40%.

Override: Select Override to modify the Net Tax amount.

Net Base Value = Base Value – Base Exemption Value
where Base Value is the total of all tax levies applied to the current 
assessment and base exemption value is the total of all exemption 
applied to the current levy.

Net Tax Amount = Net Value * Rate,

where Net Value = Base Value - Levy Value
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Net Tax Total Amount: This field displays the total amount of the current 
levy. This can be a negative or a positive amount. A negative amount 
generates a credit on the Real Property Tax bill.

It is calculated as follows:

Distributed Pro-Rata: This field displays the amount distributed if an 
exemption has been removed and its value has been pro-rated.

Notes: Enter notes or comments relevant to the selected levy. By default, the 
Notes field includes a spell check. Misspelled words are underlined.

Link Exemptions Icons

Add: Click the Add icon   to apply an exemption to the current levy. This 
opens a secondary window. 

Remove: Click the Remove icon  to remove an exemption from the list. A 
confirmation message appears. 

Link Exemptions to Levies

Select the Link Exemption tab to link an exemption to a specific levy rather 
than to the entire assessment. 

To access this form:

1. Launch Govern.

2. Open a Profile that includes Real Property Tax.

3. Open the Tax Assessment form.

4. Open the Tax Levies divider.

5. Open the Link Levy to an Exemption tab.

A secondary windows opens. This displays all the exemptions that have 
been added to the selected tax assessment record.

Net Tax Amount = Net Value * Rate,

where Net Value = Base Value - Levy Value
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6. Click the Add exemption icon 

The Exemption List opens in a secondary window.

7. Select the exemption that you want to add.

8. Click the Add Exemption icon on the Exemption List window.

9. Repeat steps 7 and 8 to add other exemptions.
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Govern Tax Exemptions

The Govern Tax Exemptions form is used for setting up and maintaining the 
tax exemptions associated with a real property tax assessment. Tax 
exemptions are defined in GNA. They can be applied before or after 
computation.

Exemptions can be applied to a Govern CAMA record or Tax Exemptions are 
defined in GNA. They can be added in a variety of ways:

• Adding a new tax exemption to the entire assessment: You can add a 
new exemption to the entire tax assessment record. The values are 
automatically calculated and displayed when you click the Save icon. 
These are based on the rates configured in GNA. See 

• Adding a group of tax exemptions: When you add an Exemption Group 
to an Assessment form, a new Tax Exemption record is created for each 
exemption in the group. These exemptions are applied to the entire 
assessment. For example, if you add the Veterans Exemption Group to a 
property record, a new Tax Exemption record is created for each of the 
three exemptions in this group. In this case, these are: Residential, Water, 
and Sidewalk. From the Tax Exemptions form, you can view the calculated 
amounts for each exemption, modify values if you have the security 
permissions, or delete an exemption record that is not required. For more 
information, see Exemption Groups Tab on page 72.

• Viewing Govern CAMA exemptions: Tax exemptions can be applied 
directly to a Govern CAMA land, building, miscellaneous structures, or 
income record if they are applicable to this record. These exemptions are 
added under the Tax Exemptions tab.

• Adding a new tax exemption to an individual tax levy: If the exemption 
is applicable to an individual levy, you can apply it directly to the levy rather 
than to the entire assessment. For details, see Link Exemptions to 
Levies on page 84.

Prerequisites

Before creating a Tax Exemptions form, you need a tax assessment record for 
the property. 

Overview
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Accessing the Tax Exemptions Form

To access the Govern Tax Real Property Tax Exemptions form:

1. Launch Govern.

2. Open a Profile that includes Real Property Tax.

3. Select the Tax Assessment form in the Forms Explorer.

4. Use the arrows to scroll to the Tax Exemptions tab.

Tax Exemptions Fields

This section describes the data entry fields on the Tax Exemptions form.

Exemption Code: Select the Exemption Code from the drop-down list 
(Table: VT_USR_EXEMPTACBTMVPP).
© 2015 MS Govern Page 87



Govern Tax: Real 
Property
By default, this list displays the Exemption codes by short description. On the  
Exemption Groups tab on the Tax Assessment form, the list displays the 
Exemption Groups.

Effective From: Click the Calendar icon next to the Effective From field 
and select the date that the current configuration of the exemption becomes 
effective.

Effective Until: Click the Calendar icon next to the Effective To field and 
select the last date that the current configuration of the exemption is effective 
for the property.

Eligible Amount: If the exemption is calculated by percentage, and only a 
portion of the tax assessment is eligible for the exemption, enter the amount in 
this field. If an amount is entered in this field, the exemption is calculated as a 
percentage of the eligible amount rather than a percentage of the total tax 
assessment. 

Frozen Assessment: Frozen assessments can be applied on properties 
owned by qualified taxpayers, such as senior citizens with limited income, as a 
protection against tax increases. 

In GNA, exemption codes can be set up by amount, percentage, or frozen 
assessment. If the exemption is defined by frozen assessment, enter an 
amount in this field. The frozen assessment exemption is calculated as 
follows:

Percent Override: Select the Percent Override option to modify the 
percentage displayed in the Percent Value field.

Percent Value: If the exemption is defined by percentage, this field displays 
the percentage entered for the exemption in GNA. 

Exemptions can be applicable before or after computation. The calculated 
amount is displayed in the Amount field if the exemption is applicable before 
computation.

Net Distributed = Base Column - Frozen Assessment, 
where Base Column is the value selected in GNA for the exemption. This 
could be any value from the Tax Assessment table, such as the Total 
Assessment, Total Land Value, or the Equalization Increase. 
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Exemption on Net: Exemptions can be applied to the tax assessment 
before or after computation. If an exemption is applied After Computation, it is 
applied to the Total Assessment value. 

If it is applied Before computation, it can be applied to any column in the Tax 
Assessment table. The amount is displayed in this field.

Amount Override: Select the Amount Override option to modify the 
amount displayed in the Amount field.

Amount: This field displays one of the following:

• The amount entered for the exemption in GNA: If the exemption is 
defined by amount.

• The following calculation: if the exemption is calculated by percentage and 
applicable before computation:

Net Amount: The Net Amount is displayed if the exemption is applicable 
After Computation. Select Override to modify this value.

Net Distributed: This field displays the total amount of the exemption 
calculated for the current exemption.

Notes: This field provides space for notes and comments.

Amount = (Base Column or Eligible Amount) * (Percentage or Maximum 
Exemption Amount),

where Base Column is the value selected in GNA for the exemption. This 
could be any value from the Tax Assessment table, such as the Total 
Assessment, Total Land Value, or the Equalization Increase.

Note: If an exemption is removed during the year, the exemption is pro-rated 
in the following fiscal year for the Levy Code set in the Govern 
TaxGeneral Parameters form in GNA.
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Tax Mailing Index

The Tax Mailing Index is used for maintaining mailing information on taxpayers 
and tax bill recipients. From this function, you can view general name and 
address information, maintain mailing, status, and forwarding information. You 
can set an account to Inactive and add dates for forwarding mail. 

To access this form:

1. Launch Govern.

2. Open a Profile that includes Real Property Tax.

3. Select the Tax Assessment form in the Forms Explorer.

4. Use the arrows to scroll to the Mailing Index tab.

Overview
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Tax Mailing Index Fields

This section describes the data entry fields on the Tax Mailing Index form. This 
form includes the following sections: 

• Status Information on page 93
• Forwarding Information on page 94

Name & Address: This field displays the name and address information for 
the selected record. This information is maintained on the Name and Address 
form. For more information, refer to the Govern Property Control guide.
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Mailing Type: Select the Mailing Type, from the drop-down list; such as, 
Managing Agent, Mortgage, Owner, Payer, Previous Customer, Temporary 
Owner or Third Party Mortgage (Table: VT_SY_MAILTYPE).

Primary Index: The Primary Index receives all original bills and other 
mailings. All other recipients receive duplicates of the originals. Also, the 
Primary Index is listed on all reports. Select this option for the property owner 
or the person to whom you are sending original bills.

The following conditions apply:

• There can be only one primary index per property.
• The property owner must be defined as the primary index, even when the 

Mortgage Company is paying the bills.

• If a primary index is not manually selected, the first name and address you 
enter automatically becomes the primary index.

• All original bills and other mailings are sent to the primary index.
• If the Status Information of the primary index is set to inactive, a duplicate 

bill is sent to the Primary Index and the original bill is sent to the 
Temporary Owner.

• All other recipients receive duplicates of the originals, unless the Do Not 
Send Bill option is selected.

• If Do Not Send Bill is selected for the Mortgage Company, an electronic 
bill is sent.

Duplicate Bill Requested: Select this option to send a duplicate of the bill 
to the current individual or company. After the batch Bill Printing process is 
run, this field is automatically deselected.

Do Not Send Bill: Select this option if you are not sending a bill to the 
current individual or company. You can select this option for the Primary Index, 
when the owner does not want to receive a bill. However, if the Do Not Send 
Bill option is selected for the Mortgage Company, an electronic bill is sent.

Priority Sequence: Use this field to create a priority sequence for sending 
out tax bills and other correspondence. If a value is entered in this field, mail is 
sent first to the names and addresses with the lowest priority sequence.

Note: If Mortgage is selected, the Loan Number field is displayed.

Note: This applies to the Real Estate Mailing Index, only.
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To set up the Priority Sequence:

• Enter 1 in the Priority Sequence field of the mailing index records for the 
individuals and companies whom you want to receive first mailing.

• Enter 2 for those whom you want to receive second mailing and so on.
• Leave this field blank those whom you want to receive mailing in the 

standard order, after the priority records are sent out. 

Notes: Enter notes and comments for the record as applicable.

Status Information

The parameters in this section are used to set accounts to Inactive and for 
ACH information.

From / Until Dates: 

Select Inactive to indicate the selected index is inactive.

• If the Inactive option is selected and dates are entered in the From / To 
fields, there will not be any bills sent during this period.

• If the Inactive option not selected and dates are entered in the From / To 
fields then the bills will be sent during this period.

ACH Information

The Automated Clearing House (ACH) feature is used for electronically 
transferring funds from the customer’s financial institution for bill payment. 

You can select an account and a range of dates for ACH payments. Refer to 
the Govern Accounts Receivable guide for details. In addition, you can enter a 
forwarding address if, for example, the winter address of the occupant differs 
from the listed address.

ACH Information: Select the customer’s account, from the drop-down list.

From / Until: Double-click in the date fields and select a range of dates from 
the pop-up calendar if the ACH is to be used during a specific time only. You 
can also enter a date in the From field or the Until field only.

Note: The ACH Information fields are available for the Primary Index. They 
are displayed only if the Primary Index option is selected.
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Forwarding Information

Start Date: Enter the starting date for using the forwarded address.

End Date: Enter the last date for using the forwarded address.

Bill by E-mail: Select this option to forward the bill to an e-mail address.

E-mail Address: Enter the e-mail address to which the you are forwarding 
the tax bills.

Other Addresses: If one or more alternative addresses exist for the client, 
the address type of these other addresses is displayed in the Other 
Addresses drop-down list. For example, if the taxpayer has a winter address 
in Florida, you could select Winter in this list. The tax bills will be sent to the 
winter address saved on the Name & Address form. For further details on 
creating name and address information, refer to the Property Control guide.

Note: The fields in this section are enabled if the Support Billing Address 
Forwarding option is selected on the System Registry Maintenance 
form in GNA.

Note: Contact the Govern Support team to set up the forwarding parameters 
for your real property bills.
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Batch Processes

This chapter describes the batch processes included in the Govern Real 
Property Tax Billing subsystem. These processes are used for updating 
multiple computations and multiple records at the same time, posting records 
to Accounts / Receivable, updating the mailing index, and generating bills.

The batch processes that are available in your deployment and the menus 
under which they appear depend on how they are set up in Govern New 
Administration (GNA). 

This section of the guide contains three main sections:

Guidelines for Running Batch Processes

This section of the guide provides information and tips for running batch 
processes in Govern OpenForms. See Guidelines for Running Batch 
Processes on page 96.

Global Batch Processes

This section describes the batch processes that are useful in all modules:

• Batch Update: This process updates or replaces existing database 
columns and updates the parcels at the same time. See Batch Update on 
page 114.

• Execute Query: This process can be used to run any update query on the 
Govern database. See Execute Query Batch Process on page 119.

• Report Scheduler: This process is used to schedule a report that is not 
associated with a batch process but needs to be run on a regular basis. 
See Report Scheduler on page 121.

Govern Tax Batch Processes

This section of the guide provides details about the batch processes that are 
specific to Govern Tax. See Govern Real Property Tax Batch Processes on 
page 123.

Overview
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Guidelines for Running Batch Processes 

Batch processes are used for computing and updating multiple records at the 
same time. Various batch processes are available in Govern for performing 
tasks such as importing and exporting data to and from the Govern database, 
updating database fields, running queries, and finalizing and posting the 
Accounts Receivable records. Govern OpenForms provides the following 
benefits for batch processing:

• Customize the menus and submenus for your batch processes.
• Add customized icons to identify the batch process.
• Set the transaction type and mode.
• Add automatic e-mail messaging.
• Add reports to Govern batch processes.
• Add schedules to run processes at a later time or on a regular basis.

You can monitor all your scheduled batch processes in the Govern Scheduler, 
in one easy-to-use central location. From this application: 

• View the progress of batch processes as they run.
• Modify or delete the scheduled processes to which you have permissions.
• View logs and details on previously-run batch processes.
• View reports generated from previously-run processes.

For further details, refer to the Govern Scheduler guide.

This section provides an overview of the general guidelines for the Govern 
Open Forms batch processes: It describes:

• Accessing Batch Processes in Govern on page 97
• Running Batch Processes on page 98
• Data Entry Fields on page 99
• Viewing Batch Process Status, Reports, and Logs on page 101
• Fiscal Year on page 99
• UNC Path on page 99
• Running a batch process on a dataset
• Scheduling Batch Processes on page 106

Overview
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Accessing Batch Processes in Govern

In Govern, your batch processes can be accessed from the Govern Batch 
Processes Explorer.

They are defined in GNA. The definition includes the options for running the 
process and all the customization. For example, if you do not use all the batch 
processes included in the default setup, you can remove the processes that 
you are not using and make it easier to find the processes that you do use. 
Batch processes are saved by Profile.

You can create a schedule for each batch process in GNA or in Govern. Then, 
view and monitor the process from the Govern Scheduler.

To access your batch processes:

1. Launch Govern.

2. Open the Profile that contains the batch process.

3. Open the Batch Processes Explorer.

4. Select the process that you want to run.
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Running Batch Processes

There are three options for running a batch process in Govern:

• Execute: Click Execute to run the process immediately.
• Schedule: Click Schedule to define the specific date and time that you 

want to run the batch process or to set up a schedule for running it on a 
recurring basis, at regular intervals, such as daily, weekly, hourly, etc.

• Activate (Is Enabled): Create and save a schedule for a batch process. 
Deselect the Activate option until you are ready to use to it. Or deselect 
this option if you want to stop running the process temporarily. Select 
Activate when you are ready to use the schedule.

For further details about running and scheduling batch processes, see  
Scheduling Batch Processes on page 106. 
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Data Entry Fields

If a field is optional you can leave it blank to process all records that meet the 
other criteria on the form. For example, if a date field is optional, leave it blank 
to process records from any date. 

Fiscal Year

The Year is required on many batch process forms. It most cases, this is the 
same as the Profile Year displayed in the Fiscal Year field in the Home menu. 
The batch processes are called from the Govern application. However, they 
are run in a separate application and need to be entered.

UNC Path

Several batch processes generate files containing information from the 
Govern database that is required by third parties. For example, a batch 
process could generate accounts receivable information about tax accounts 
for a bank. Other batch processes import a comma separated values (csv) or 
text (txt) file containing information from an external database to be imported 
to the Govern database.

The Import and Export Names in Mailers+4 Format are examples. See  
Mailers+4 Format: Importing and Exporting Names on page 136.

For these files, it is recommended to enter the path for exported files on the 
Attachments tab of the Batch Process Definition Editor form in GNA. That way, 
the files are saved in the database and can be retrieved at any time. 

When you specify the path for these files, it is recommended to use UNC 
format.

For example, enter:

\\GovernSchedulerServer\BatchProcess\ExportFiles

This ensures that everyone knows the computer where the files are saved and 
is able to retrieve them easily. If you enter a mapped drive, the exported file 
could be saved to the local computer or one of the servers where scheduled 
batch processes run. 
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You can specify the network path and / or an ftp site for exported or imported 
files when you define the batch process in GNA. Refer to the Govern 
Scheduler guide for details.

Running a Batch Process on a Saved Dataset

If you want to run a batch process on a group of parcels, such as parcels 
within a certain area or tax jurisdiction, you need to create and save a dataset. 
You can also use an existing dataset. In Govern, a dataset is a saved group of 
property records:

To create a new dataset:

1. Launch Govern.

2. Perform a search and load the parcel records that you want to include in 
the dataset to the tree view.

3. Open the Saved Dataset panel on the right.

4. Click the New Dataset icon .

The Create New Dataset dialog box opens.

5. Enter a name for the dataset in the Name text box.
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6. Click Save.

7. Click the Add Items icon  to add the parcels currently in the tree view 
to the dataset.

For further details on creating Datasets, refer to the Govern General 
Information guide.

Viewing Batch Process Status, Reports, and 
Logs

When you run a batch process from Govern, a progress bar is displayed on 
the Govern Ribbon. 

When the process is running, various messages are displayed, such as the 
estimated time to complete the process, the total time, etc.

Information messages are displayed under the progress bar.
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Completed Batch Processes

When the process completes successfully, the progress bar is green. When it 
completes, “The End” is written in the progress bar.

Messages are displayed with the following icons:

To copy the messages and save them to another file, click the copy to 

Clipboard icon 

Viewing Reports in the Govern Scheduler

After a scheduled batch process has run, you can view the reports and logs 
generated by the process in the Govern Scheduler History Logs.

To view the report:

1. Launch the Govern Scheduler.

Icon Description Definition

Attachment Reports and any files that are 
generated by the batch process 
are listed and can be opened from 
Govern if the process runs from 
Govern.

Error Errors generated by the batch 
process are listed with the error 
icon.

Warning Warnings generated by the batch 
process are listed with the 
warning icon.

Information Information messages generated 
by the batch process are listed 
with the information icon.
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2. Select the schedule in the top section of the scheduler.

3. Select the log.

4. Select the attachment icon in the Details section.

The report opens.

Viewing Errors

When you run the batch process, a Progress Bar is displayed in the Batch 
Processes menu in the Govern Ribbon.

If errors are generated, the Progress Bar turns red and the Error icon appears.

Tip: You can create a schedule for running reports that are not associated 
with a batch process. See Report Scheduler on page 121.
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If errors occur, click on the Error icon  to display system information about 
the errors. Information is also written to the Error Log. The file name and path 
to the error log are displayed in the Batch Process Error window.

Viewing Logs

If a log is generated from the batch process, a message appears. 

Click on the Notification icon to view the log.
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By default, the log file is saved in the same location as the import file.

You can also view the history logs and the event detail logs in the Govern 
Scheduler, at any time. For details, refer to the Govern Scheduler guide.
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Scheduling Batch Processes

You can set up one or more schedules for each batch process in order to run 
them at a later time or at regular intervals, such as on a daily, weekly, or 
monthly basis.

You can create the schedules in Govern. Then, monitor the batch processes in 
the Govern Scheduler. You cannot modify or delete a schedule in Govern. For 
more information about maintaining schedules, refer to the Govern Scheduler 
guide.

To set up a batch process schedule:

1. Launch Govern.

2. Select the batch process from the Batch Processes explorer.

3. Select the Schedule divider.

Overview
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4. Enter a name for the batch process schedule in the Name field. This is 
displayed in the Govern Scheduler menu. This name could include, for 
example, the name of the process and how often you are running it, such 
as Daily – Apply Deposits.

5. Enter a description for the batch process schedule. This could explain the 
process or the reasons for creating the schedule.

6. Select the Activated option when you are ready to use the schedule. 

7. Select the owner of the batch process from the Owner drop-down list. By 
default, this parameter displays the user name of the logged-in user.

Note: This option is selected by default. You can deselect it in order to 
deactivate the schedule. Set up the schedule. Then, select this 
option when you are ready to use the schedule.
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8. Select one of the following under Schedule by. Then, follow the applicable 
procedure.
• One Time: See page 108.
• Day: See page 109.
• Week: See page 110.
• Month: See page 111.

Setting Up a Schedule for Running a Batch 
Process Once

Use this procedure to create a schedule for running a batch process at a later 
date but once only.

1. Set up the general information for the schedule as described at the 
beginning of this section. See Scheduling Batch Processes on page 106.

2. Select One Time under Schedule by.

3. Click the calendar icon beside the Start date parameter and select the 
date and time to run the process.

4. Click Save.
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Setting Up a Schedule by Day

Use this procedure to set up a schedule for running a batch process on a daily 
basis, or more frequently such as every hour.

1. Set up the general information for the schedule as described at the 
beginning of this section. See  Scheduling Batch Processes on page 106.

2. Select Daily in the Settings group box.

3. Click the calendar icon beside the Start date parameter and select the 
date and time to run the process.

4. Select the Expires on check box if applicable.

5. Click the calendar icon beside the Expires on field and select ending date 
and time for the process.

6. Enter the interval between processes in days in the Recur every... days 
fields. For example, if you want to run the process every day, enter 1. If 
you want to run the process every two days, enter 2, and so on.

7. Select the Repeat every check box to run the process more frequently 
than once a day.

8. Enter the minutes between processes in the Minutes text box.

9. Click Save.
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Setting Up a Schedule by Week

Use this procedure to set up a schedule for running a batch process on a 
weekly basis, or more frequently such as every Monday, Wednesday, and 
Friday, or on an hourly basis.

1. Set up the general information for the schedule as described at the 
beginning of this section. See  Scheduling Batch Processes on page 106.

2. Select Weekly in the Settings group box.

3. Click the calendar icon beside the Start date parameter and select the 
date and time to run the process.

4. Select the Expires on check box if applicable.

5. Click the calendar icon beside the Expires on field and select ending date 
and time for the process.

6. Enter the interval between processes in weeks in the Recur every... 
weeks fields. For example, if you want to run the process every week, 
enter 1. If you want to run the process every two weeks, enter 2, and so 
on.
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7. Select the day or days of the week to run the process. You can select as 
many days as applicable.

8. Select the Repeat every check box to run the process more frequently 
than once a day.

9. Enter the minutes between processes in the Minutes text box.

10. Click Save.

Creating a Schedule by Month

Use this procedure to set up a schedule for running a batch process on a 
monthly basis, or more frequently such as three or four times a month, or on 
an hourly basis.

1. Set up the general information for the schedule as described at the 
beginning of this section. See Scheduling Batch Processes on page 106.

2. Select Monthly in the Settings group box.

3. Click the calendar icon beside the Start date parameter and select the 
date and time to run the process.

4. Select the Expires on check box if applicable.
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5. Click the calendar icon beside the Expires on field and select ending date 
and time for the process.

6. Enter the interval between processes in months in the Recur every... 
months fields. For example, to run the process every month, enter 1; to 
run the process every two months, enter 2; and so on.

7. Select the day or days of the month to run the process. You can select as 
many days as applicable.

8. Select the Repeat every check box to run the process more frequently 
than once a day.

9. Enter the minutes between processes in the Minutes text box.

10. Click Save.
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Global Batch Processes

The following batch processes can be used with all modules. 

Batch Update

Run the Batch Update batch process to update one or more database 
columns and the applicable parcels at the same time. You can add to or 
replace existing values and set one or more conditions for the update. See 
Batch Update on page 114.

Execute Query

Use the Execute Query batch process to run an update query on the Govern 
database. You can select a query and run it on the fly or create a schedule to 
run the query at a later time or on a regular basis.

You can run only one query each time that you execute this batch process. 
However, you can create multiple schedules and associate a different query 
with each process. You can also create multiple batch processes of the same 
type and associate different reports, e-mails, and schedules with each one.

See Execute Query Batch Process on page 119.

Report Scheduler

The Report Scheduler is used to schedule a report that is not associated with 
a batch process but needs to be run on a regular basis. You may, for example, 
want to run a report every night that does not require any data from a batch 
process. See Report Scheduler on page 121.

Overview
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Batch Update

Run the Batch Update batch process to update one or more database 
columns and update the applicable parcels at the same time. You can add to 
or replace existing values and you can set one or more conditions for the 
update.

Prerequisite

Create the data mapping for the tables and columns that you want to update. 

To create the data mapping:

1. Launch GNA.

2. Select Editors > Data Mapping Editor.

Overview

Note: It is recommended to back up your database before running this 
process.
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3. Enter a code for the element in the Name text box. This identifies the 
element in the database.

4. Enter descriptive names in the short and long description text boxes for 
the data element. The short description appears in the Element Name 
column in the Elements to Update tab of the Batch Update batch process. 
For details on this tab, see page 116.

5. Select the table from the Table Name drop-down list for the Govern 
database table that you want to update.

6. Select the column from the Column Name drop-down list that 
corresponds to the field you want to update.

7. Select the data element type, such as String, Date, or Decimal according 
to the type of data you are updating.

8. Click Save.

Refer to the Govern New Administration (GNA) guide for details on this editor.

Running the Batch Update

To run the Batch Update batch process:

1. Launch Govern.

2. Open the Batch Processes Explorer.

3. Select Batch Update*.
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*The path and name of the process can vary according to the setup.

Parcels to Update

To select the parcels for the Batch Update process:

1. Select the Parcels to Update tab.

2. Do one of the following:

• Select the Search icon  to perform a search for the parcels to 
update.

• Select the Transfer from Treeview icon  to transfer all the parcels 
that are in the current TreeView to the batch process.

Elements to Update

To select the elements to update:

1. Select the Elements to Update tab.

This tab uses the data mapping from GNA.
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2. Select the element to update from the Element Name column.

The table column name and columns are automatically displayed, 
according to the mapping in GNA.

3. Select Add or Replace from the Action column, depending on the action 
you want to perform.

4. Enter the value in the Value column to add or replace.

Adding Conditions

Add a condition to the update in order to update only the parcels that 
correspond to specific values:

1. Click the ellipsis button  in the Conditions column to open the 
Conditions window.
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2. Click the Add button to add a column.

3. Select the operator, such as equal or greater than, from the Operator 
drop-down list.

4. Enter the value to the condition.

5. Repeat steps 2 to 4 if you are updating multiple columns.

6. Click OK.

7. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to run this batch process at a later time. See 

Scheduling Batch Processes on page 106.
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Execute Query Batch Process

Use the Execute Query batch process to run an update query on the Govern 
database. You can select a query and run it on the fly or create a schedule to 
run the query at a later time or on a regular basis.

You can run only one query each time that you execute this batch process. 
However, you can create multiple schedules and associate a different query 
with each process. You can also create multiple batch processes of the same 
type and associate different reports, e-mails, and schedules with each one.

Prerequisite

Add the query that you want to use in the SQL Definition Setup Editor in GNA. 
The query must be an update query.

Running the Execute Query Batch Process

To run the batch process. 

1. Launch Govern.

2. Open the Batch Processes Explorer.

3. Select Execute Query.

*The path and name of the process can vary according to the setup.

Overview
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4. Select the query from the Query Name drop-down list.

5. Enter the required data in the Query Parameters text boxes.

6. Do one of the following:
• Click Execute to run the process immediately.
• Select the Schedule tab to set up a schedule for the batch process. 

See Scheduling Batch Processes on page 106.

Note: The parameters are required but vary depending on the query 
selected for the process.
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Report Scheduler

The Report Scheduler is used to schedule a report that is not associated with 
a batch process but needs to be run on a regular basis. You may, for example, 
want to run a report every night that does not require any data from a batch 
process.

Creating a Schedule for a report is the same as creating one for a batch 
process. You can set up the schedule by day, week, or month, or to be run 
once only.

You can add multiple reports to a single schedule; so that all the reports run at 
the same time. Alternatively, you could create multiple schedules: one to run 
each report. 

There are no parameters to set in Govern for the Report Scheduler.

Running the Report Scheduler 

To run the batch process. 

1. Launch Govern.

2. Open the Batch Processes Explorer.

3. Select Report Scheduler*.

*The path and name of the process can vary according to the setup.

4. Do one of the following:
• Click Execute to run the process immediately.

Overview
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• Select the Schedule tab to set up a schedule for the batch process. 
See Scheduling Batch Processes on page 106.
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Govern Real Property Tax Batch 
Processes

This section of the guide describes the batch processes that are specific to 
Govern Tax.

Add Levy to Parcels

Run the Add Levy to Parcels batch process to apply a tax levy to a group of 
parcels. You can apply the levy to all parcels in a given assessment year. or to 
only those within a saved dataset and / or those that already have a specific 
levy applied. See Add Levy to Parcels on page 126.

Compute Formulas & Logical Expressions

Run this process to recalculate a group of selected formulas and logical 
expressions. Typically, this process is run when the value of a constant 
changes. If the constant is used in multiple formulas and expressions, you can 
run the batch process and update them all automatically rather than opening, 
modifying and saving each one. See Compute Formulas and Logical 
Expressions on page 128.

Compute Levies and Exemptions

Run this process to recalculate the levies and/or the exemptions after a 
change in tax rates or exemption amounts / percentages. See Compute 
Levies and Exemptions on page 130.

Finalize Tax Roll

Run the Finalize Tax Roll batch process to finalize the tax assessment records 
for a group of parcels or for all parcels in your organization. See Finalize Tax 
Roll on page 132.

Generate Bill Printing Sequence Number

Run the Generate Bill Sequence Numbers to generate sequence numbers for 
the Real Property tax bills. See Generate Bill Printing Sequence Numbers on 
page 134.

Overview
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Mailers+4 Format: Importing and Exporting Names

The Import and Export Names in Mailers+4 batch processes perform name 
and address verification and correction on multiple records at the same time. 
They ensure that addresses are formatted according to the Mailers+4 
American and Canadian postal standard. See Mailers+4 Format: Importing 
and Exporting Names on page 136.

Melissa Name and Address Verification

The Melissa Name and Address Formatting batch process is designed for 
users who have installed Melissa Data software. This software verifies names 
and addresses on an individual basis and ensures that they are formatted 
according to American and Canadian postal standards.

The Melissa Name and Address Formatting batch process updates multiple 
records at the same time. It could be run, for example, when multiple name 
and address records have been added in a batch import process. It is also 
recommended to run this process after running the Export Names to 
Mailers+4 batch process. See Melissa Name and Address Formatting on 
page 141.

Post Partial Billing

Run this process to post all the partial-billing records to the Govern Accounts 
Receivable module. See Partial Billing Posting on page 143.

Post to A/R

Run this process to transfer calculated values to the Govern Accounts 
Receivable module. See Posting to Accounts Receivable on page 148.

Re-Extract Mailing Index

Run the Re-extract Mailing Index batch process to regenerate the mailing 
index table and update the bill sort sequence. 

When a computation is made, the sort sequence is automatically updated; 
however, if you make changes during the year, or if you need to print other 
bills, it is recommended to run this process, as well as the Generate Bill 
Sequence Number process, and the Bill Printing process.

Note: Before running this batch process, run the Re-extract Mailing Index 
process as described under Re-extract Mailing Index on page 150.
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This process updates the TAX_NOTICE_1 and TAX_NOTICE_2 columns in 
the TX_POST_MASTER table, according to whether the balance is due in the 
first or second installment. See Re-extract Mailing Index on page 150.

Tax Deferral Transfer Batch Process

Run the Tax Deferral Transfer batch process to transfer the tax deferral 
information and post the outcome to the Accounts / Receivable module. See  
Tax Deferral Transfer Batch Process on page 152.

Tax Service Organization (TSO) Batch Processes

The following batch processes are provided for TSO data:
• TSO Registration (Output) procedure: this creates an ASCII file 

containing the names of the taxpayers using a TSO service. This file does 
not include the amount of tax due or any installment information. After it is 
generated, send it to the applicable TSO companies for verification.

• TSO Bill Request (Input) procedure: this loads the updated information 
from the TSO company. The mailing index, billing files, and accounts 
receivable information, such as TSO and bank number, are updated.

• TSO Tax Amount (Output) procedure: this generates a file containing the 
amount due for each taxpayer per installment.

• TSO Batch Payment Generation (Input) procedure: this uploads the 
tape containing the payment information from the TSO to Govern.

See TSO Batch Processes on page 154.

Update Owner in Mailing Index

Run this process to ensure that the Real Property Mailing Index is up to date 
with all the current owners. This process verifies the current mailing index. If 
the owner field contains the previous owner, it updates this with the current 
owner from the PC_OWNER table. See Update Owner Data in Mailing 
Index on page 163.
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Add Levy to Parcels

Run the Add Levy to Parcels batch process to apply a tax levy to a group of 
parcels. You can apply the levy in a variety of ways:

• To all parcels in a given assessment year
• To the parcels within a saved dataset
• To the parcels that already have a specific levy applied

Use the following procedure to set up the Add Levy to Parcels batch process. 
You can then click Execute to run the process immediately or Schedule to run 
it at a later date or on a regular basis.

To run the batch process

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Add Levy to Parcels *

*The path and process name can vary according to the setup in GNA.

Overview
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4. Enter the tax assessment year in the Year text box.

5. Select a saved dataset from the Dataset Name drop-down list to run the 
process on the saved dataset.

For details about creating and using saved datasets, see Add Levy to 
Parcels on page 126.

6. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Compute Formulas and Logical 
Expressions

Run the Compute Formulas and Logical Expressions Batch Process to update 
multiple formulas and logical expressions in the Real Property Tax Billing 
subsystem at the same time. You can run the process for a specific year or on 
a saved dataset if required.

Typically, this process is run when the value of a constant changes; for 
example, at the start of a new fiscal year. If the constant is used in multiple 
formulas and expressions, you can run the batch process to automatically 
update all at once, rather than opening, modifying and saving each one.

Setting Up the Compute Formulas and Logical 
Expressions Batch Process

Use the following procedure to set up the Compute Formulas and Logical 
Expressions batch process. You can then click Execute to run the process or 
immediately or Schedule to run it at a later date or on a regular basis.

To set up the batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Compute Formulas and Logical Expressions*.

Overview

Note: Formulas and Logical Expressions are automatically run in the 
required order of computation. All dependencies are calculated first. 
For example, if a calculation in a logical expression is dependent on 
the result of a calculation in a formula, the formula is calculated first.
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*The path can vary according to the setup in the Govern System 
Configuration and Administration.

4. Select Real Property Tax from the Subsystem drop-down list.

5. If you want to compute the formulas and logical expressions for a selected 
group of parcels only, you need to create and save a new dataset or use 
an existing one. For further details, see Running a Batch Process on a 
Saved Dataset on page 100. 

6. Enter the fiscal year for the records you want to update in the Year ID text 
box.

7. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Compute Levies and Exemptions

The Compute Levy and Exemption form is used to recompute the levies and/ 
or exemptions after a change in the tax rates, exemption amounts, or 
percentages. 

To run the batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Compute Levies and Exemptions*.

*The path and process name can vary according to the setup in GNA.

4. Enter the tax assessment year in the Year text box.

5. Do one of the following:
• Select Check Exemption Dates to verify the last date that the 

exemption value was modified. If the change was made after the last 
assessment, recompute the exemptions and applicable levies.

• Leave this option unchecked to recompute all levies and exemptions.

Overview
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6. Select Final Compute if you are ready to close the current fiscal year. This 
process copies all Real Property values from the current year to the next 
fiscal year.

7. If you want to compute the levies and exemptions for a selected group of 
parcels only, you need to create and save a new dataset or use an existing 
one.For further details, see Running a Batch Process on a Saved 
Dataset on page 100. 

8. Select the A/R Cycle from the Cycle Code drop-down list.

This is a required field. The A/R Cycle is associated with the A/R Class 
Code in the administrative setup for Real Property Tax.

9. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.

Note: It is recommended to run the computation before running the Final 
Compute.
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Finalize Tax Roll

Run the Finalize Tax Roll batch process to finalize the tax assessment records 
for a group of parcels or for all parcels in your organization. This process sets 
the HISTORY_ONLY field to -1 on the selected parcels in the TX_RE_ 
ASSESSMENT table. 

Prerequisite

A Saved Dataset is required for selecting the parcels for running the batch 
process. See Running a Batch Process on a Saved Dataset on page 100. 

 Running the Finalize Tax Roll Batch Process

To run the Finalize Tax Roll batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Finalize Tax Roll*

*The path and file name can vary according to the setup in GNA.

4. Enter the fiscal year of the records you are finalizing in the Year text box.

Overview

Note: This process is a requirement when you change to a new fiscal year.
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5. Do one of the following:
• Select All Parcels to finalize all the tax assessment records in your 

organization for the fiscal year.
• If you want to finalize the tax roll for a selected group of parcels only, 

you need to create and save a new dataset or use an existing one. For 
further details, see Running a Batch Process on a Saved Dataset on 
page 100. 

6. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Generate Bill Printing Sequence 
Numbers

Run the Generate Bill Sequence Numbers batch process to generate 
sequence numbers for the Real Property tax bills. Sequence numbers are 
generated in the Mailers+4 Format or by adding one to the last sequence 
number depending on which option you are using. Bills are saved to the 
TX_POST_MASTER table.

Running the Bill Printing Sequence Batch Process

To run the Bill Printing Sequence Numbers batch process:

1. Launch Govern.

2. Open the Batch Processing explorer.

3. Select Generate Bill Printing Sequence Numbers*.

Overview

Tip: Run the Re-extract Mailing Index Batch Table batch process prior to this 
process to ensure that the mailing index is up to date. See Re-extract 
Mailing Index on page 150. 
 
If you are using Melissa Data address verification software, run the 
Import and Export Mailers+4 and Melissa Names and Address 
formatting batch processes to ensure that all names and addresses are 
formatted correctly. See Mailers+4 Format: Importing and Exporting 
Names on page 136 for details.
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*The path varies according to the setup in GNA.

4. Enter the fiscal year for the tax records in the Year parameter.

5. Select Sequence from Mail +4 Format if you are using Mail +4 Format. 
Otherwise, leave this option blank.

6. Select Minimum Balance to Print Bills and enter a minimum balance for 
the printed bills. If tax bills are less than this amount, they are not printed.

The amount that you enter in this field is displayed each time you open the 
form. To change the amount, reselect this option.

7. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Exporting Names

The Import and Export Names in Mailers+4 batch processes perform name 
and address verification and correction on multiple records at the same time. 
They ensure that addresses are formatted according to the Mailers+4 
American and Canadian postal standard. 

For Real Property Tax, the batch processes are run in the following order:

1. Run the Export Mailers+4 Batch Process.

2. Run the Melissa Name and Address Formatting Batch Process. See  
Melissa Name and Address Formatting on page 141.

3. Run the Import Mailers+4 Batch Process. See Import Names in Mailers+4 
Format on page 139.

4. Run the Generate Bill Printing Sequence Number. This populates the 
TX_POST_ MASTER table with the required billing data. See Generate 
Bill Printing Sequence Numbers on page 134.

Prerequisite

Before running this process, calculate the billing data and post the information 
to Accounts / Receivable.

Export Names in Mailers+4 Format

The Export Names in Mailers+4 Format process creates an Access database 
file with the name records for the properties with calculated assessments. This 
process adds the following parameters to the file.
• SEQUENCE: This is the Mail Distribution Sequence
• CRRT: This is the Carrier Route Code
• DPBC: This is the Delivery Point
• CONTAINER_NUMBER
• PACKAGE_NUMBER

Overview
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Once this file is generated, run the Melissa Address Verification software to 
update the name and address records with this information.

Next, run the Import Names in Mailers+4 Format to update the NA_ NAMES 
table with the formatted data. 

Accessing the Export Names in Mailers+4 Format 
Process

To access the Export Names in Mailers+4 Format batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Export Names in Mailers+4 Format*.

*The path varies according to the setup in GNA.

4. Select the subsystem from the Subsystem drop-down list.
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5. If you selected Real Property Tax, select the A/R Cycle from the A/R 
Cycle Code drop-down list.

6. Select the Different Sequence for Same Name if Repeated option in 
order to generate a new bill sequence number for a name if more than one 
record exists for the name. 

For example, the same name may be listed for two or more subsystems in 
the POST_MASTER table, once under Real Property Tax and again under 
Motor Vehicle Excise Tax. 

Otherwise, deselect this option to use the same sequence number for all 
records associated with a name. 

7. Select one of the following from the Message on Bill drop-down list in 
order to process the bills with an associated message only.:
• Duplicate Bill
• Duplicate Second Half Bill
• For Information Only
• General
• Mortgage Bill
• Owner with Mortgage
• Receipt
• Third Party Notification

Otherwise, leave this field blank to copy all names, regardless of the 
associated message. 

The messages are defined in the Bill Messages Setup form, in Govern 
Admin (Table: VT_USR_ MESSBILL). Refer to the Govern Super User 
guide for details on this process.

8. Select one of the following to add another filter to the process:
• Single Bills Only: Select this option to process only the names that 

are associated with single bills. The Single Bill setting is flagged in 
TX_POST_MASTER after an initial posting is made in the fiscal year. 
This indicates that a single property is associated with the name. 

• Multiple Bills Only: Select this option to process only the names that 
are associated with multiple bills. The Multiple Bill field is flagged in 
TX_POST_MASTER after an initial posting is made in the fiscal year. 
This indicates that multiple properties are associated with the name. 

Note: This field is enabled only if A/R Master by Cycle Code is selected 
on the Accounts Receivable General Parameters form. Refer to 
the Accounts Receivable guide for details.
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• Duplicate Bills Only: Select this option to process only the names 
that are associated with duplicate bills. This also includes the names 
for which the Duplicate Bill Requested option is selected. 

9. Select the Primary Name only to run the process only on the names that 
are selected as the primary index, in the Mailing Index, or as the temporary 
owner(s) if the primary index is inactive.

10. Select With Payments to run the process only on the names associated 
with accounts with payments.

11. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.

Import Names in Mailers+4 Format

The Import Names in Mailers+4 Format process imports the Access database file 
that was updated with the Mailers+4 Format data in the NA_NAMES table. 

Prerequisite

Run the Export Names in Mailers+4 Format and the Melissa Name and 
Address Formatting batch processes.

Once the database file is updated, run the Import Names in Mailers+4 Format to 
update the NA_ NAMES table with the formatted data. 

Accessing the Import Names in Mailers+4 Format 
Process

To access the Import Names in Mailers+4 Format batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Import Names in Mailers+4 Format*.
© 2015 Harris Govern Page 139



Govern Tax: Real Property 
*The path varies according to the setup in GNA.

4. Select the subsystem, from the Subsystem drop-down list, that was 
selected when the export file of Mailers+4 data was generated. 

5. Click the ellipsis button  and select the path and file containing the 
exported file of the Mailers+4 data.

6. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.

7. When the process is complete, run the Generate Bill Printing Sequence 
Numbers batch process and select the Use Sequence from Mailers+4 
Format option. See  Generate Bill Printing Sequence Numbers on 
page 134.

Note: It is recommended to use UNC format for this path.
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Melissa Name and Address Formatting

The Melissa Name and Address Formatting batch process is designed for 
users who have installed Melissa Data software. This software verifies names 
and addresses on an individual basis and ensures that they are formatted 
according to American and Canadian postal standards.

The Melissa Name and Address Formatting batch process updates multiple 
records at the same time. It could be run, for example, when multiple name 
and address records have been added in a batch import process. It is also 
recommended to run this process after running the Export Names to 
Mailers+4 batch process. See Export Names in Mailers+4 Format on 
page 136.

It verifies the records with the Melissa software. Then it formats the name and 
address data, in the FREE_LINE_1 through FREE_LINE_6 columns of 
NA_NAMES, according to the Country Format set in the System Registry. 

Prerequisite

Melissa Data software must be installed. For details, refer to the Installation of 
Melissa Data & Intelligent Mail Barcode guide.

Accessing the Melissa Batch Process

To access the Melissa Name and Address Formatting batch process:

1. Launch Govern.

2. Select the Batch Processes >explorer.

3. Select Melissa Name and Address Formatting*.

Overview
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*The path varies according to the setup in GNA.

There are no parameters for this batch process.

4. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Partial Billing Posting

Run the Partial Billing Posting batch process to generate partial billing records 
and post them to the Govern Accounts Receivable subsystem. 

The Partial Billing Posting process creates records in the following tables:
• AR_MASTER
• AR_SUMMARY
• AR_DETAIL
• AR_GL_TRANSACTIONS
• USR_AUDIT_POSTING.

Conditions

This Partial Billing Posting batch process creates a Partial Billing record for all 
parcels that have a Tax Audit record with the Partial Billing option selected, 
as in the following screen shot.

Overview
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Exception

If Not Subject to Partial Billing is selected on the Tax Assessment form, a 
partial billing record is not created for the applicable parcel.

Cycle Code

The Cycle Code is a required field if the A/R Master by Cycle Code option is 
selected for the Real Property Tax subsystem on the Accounts Receivable 
General Parameters form in Govern Admin.
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Refer to the Govern Accounts Receivable guide for details on defining the 
Real Property Tax parameters for accounts receivable 

Running the Partial Billing Posting Batch 
Process

To run the Partial Billing Posting batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Partial Billing Posting*.
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*The path varies according to the setup in GNA.

4. Enter the fiscal year for the tax records in the Year text box.

5. Select a dataset from the Saved Dataset field if applicable.

If you want to run the Partial Billing Posting on a selected group of parcels 
only, you need to create and save a new dataset or use an existing one. 
See Running a Batch Process on a Saved Dataset on page 100. 

6. Select a range of dates using the calendars in the From and To text boxes 
in order to run the process on records created within certain dates only.

7. Select the A/R cycle from the Cycle Code drop-down list.

This is a required field if your organization defines Real Property Tax by 
Cycle Code. The A/R Cycle is associated with the A/R Class Code in the 
administrative setup for Real Property Tax.

8. Enter an installment number from the Adjust Instal# to run the process on 
records for a specific installment.

9. Enter a prefix for the partial billing posting records in the Bill Prefix text 
box if applicable.

10. Select the Use New Bill Number if you want to generate a new bill 
number for the partial billing posting.

Deselect this option if you want to use the same bill number as the tax 
assessment. 

11. Do one of the following:
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• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Posting to Accounts Receivable

Run the Posting to A/R batch process to transfer the computed Real Property 
tax values to the Govern A/R tables and update the required G/L records.

When you run the Posting to A/R batch process, a new Tax Audit record is 
created for all selected parcels. The Entry Code for these records is set to 
Original. The Frozen ID is updated and a new entry is listed in the History 
Panel. For further details, see Tax Audit on page 76.

To run the Posting to A/R batch process

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Post to A/R*.

*The path can vary according to the setup in GNA.

4. Enter the tax assessment year in the Year text box.

5. If you want to run the Posting to A/R for a selected group of parcels only, 
you need to create and save a new dataset or use an existing one. For 
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Receivable
further details, see Running a Batch Process on a Saved Dataset on 
page 100. 

6. Select the A/R cycle from the Cycle Code drop-down list.

This is a required field. The A/R Cycle is associated with the A/R Class 
Code in the administrative setup for Real Property Tax.

7. Select the Order by Name Index option to sort the bills by the Name 
Index (NA_ID) instead of Parcel Index (P_ID).

8. Select Post Estimated Tax to post the estimated tax amounts. This option 
is displayed if Use Estimated Tax is selected on the Govern Tax > Real 
Property Tax > General Parameters form in GNA. The amount is 
calculated as described in the Administrator section of this guide.

9. Select Generate Discount for Prepayments if you want to  calculate and 
apply the discount to prepayments. Otherwise, the discount is applied to 
full payments only. 

10. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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Re-extract Mailing Index

Run the Re-extract Mailing Index Batch Table process to regenerate the 
mailing index table and update the bill sort sequence. 

When a computation is made, the sort sequence is automatically updated; 
however, if you make changes during the year, or if you need to print other 
bills, it is recommended to run this process, as well as the Generate Bill 
Sequence Number process, and the Bill Printing process.

This process updates the TAX_NOTICE_1 and TAX_NOTICE_2 columns in 
the TX_POST_MASTER table, depending on whether the balance is due in 
the first or second installment.

To access the batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Re-extract Mailing Index*.

4. Enter the year in which the tax bills are saved in the Year text box.

5. Select First Half Reminder to extract the names that have a remaining 
balance for the first installment.
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6. Select Second Half Reminder to extract the names that have a remaining 
balance for the second installment.

7. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.

Note: Select both options (First Half Reminder and Second Half Reminder) 
to extract the names that have a remaining balance after the second 
half.
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Tax Deferral Transfer Batch Process

Run the Tax Deferral Transfer batch process to transfer the tax deferral 
information and post the outcome to the Accounts / Receivable module.

To run the Tax Deferral batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Tax Deferral*

*The path varies according to the setup in GNA.

4. Enter the fiscal year for the tax records that you want to transfer in the 
Year text box.

5. Select Tentative to transfer the tax records to the AR_DETAIL table 
without finalizing them. You can delete the records created using this 
option.

6. Select Delete Tentative to delete the records created through a Tax 
Deferral Transfer process using the Tentative option.

7. Select Final Posting to post the tax deferral records to the Govern 
Accounts Receivable subsystem. As with the Tentative option, records are 
created in the AR_DETAIL table, but are final. Posted records cannot be 
modified or deleted.

8. Do one of the following:
• Click Execute to run the process immediately.
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Tax Deferral Transfer 
Batch Process
• Click Schedule to create a schedule to run the process at a later date 
or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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TSO Batch Processes

Processing Tax Service Organization (TSO) Data

Four procedures are included for processing TSO data. Typically, only the 
TSO Tax Amount (Output) and TSO Batch Payment Generation (Input) 
procedures are used. If you are running all four, it is important to proceed in 
the following order:

1. Run the TSO Registration (Output) procedure: this creates an ASCII file 
containing the names of the taxpayers using a TSO service. This file does 
not include the amount of tax due or any installment information. After it is 
generated, send it to the applicable TSO companies for verification.

2. On receiving the updated files from TSO companies, run the TSO Bill 
Request (Input) procedure: this loads the updated information from the 
TSO company. The mailing index, billing files and accounts receivable 
information, such as TSO and bank number, are updated.

3. Run the TSO Tax Amount (Output) procedure: this generates a file 
containing the amount due for each taxpayer per installment.

4. Run the TSO Batch Payment Generation (Input) procedure: this uploads 
the tape containing the payment information from the TSO to Govern.

TSO Registration (Output)

Run this procedure to generate an ASCII file containing all your TSO accounts 
or refine it to include only those from a specific organization. This file contains 
the names of the taxpayers using a TSO service without including the tax 
amount or installment information. It is sent to the applicable TSO companies 
for verification.

To run the batch process:

1. Launch Govern.

2. Select Batch Processes > TSO Registration*.
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*The name of the process and the path can vary according to the 
administrative setup in GNA.

3. Enter the default fiscal year of the department. This is the year displayed in 
the Profile tab at the top of the form. 

This is a required field. The batch process is separate from the Govern 
application.

4. Enter the TSO number or leave the file blank to process all accounts.

5. Click Browse and select the directory where you want to save the TSO 
Registration file generated by the process.

6. Select the Line Terminator for the file: None, Carriage Return (CR) or 
Carriage Return Line Feed (CRLF).

7. Do one of the following:
• Click Execute to run the process immediately.
• Select the Schedule tab to set up a schedule for the batch process. 

See Scheduling Batch Processes on page 24.

TSO Bill Request (Input)

Run this procedure to load the updated information from the TSO company. 
The mailing index, billing files and accounts receivable information, such as 
TSO and bank number, are updated.
• Additions, such as new parcels are marked by an A.
• Changes or corrections are marked by a C.
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• Deletions to indicate the TSO company no longer services the specified 
parcels are marked by a D.

To run this batch process:

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select TSO Bill Request *.

*The name of the process and the path can vary according to the 
administrative setup in GNA.

4. Click the Browse button and select the file that you are importing.

5. Select Carriage Return (CR) or Carriage Return / Line Feed (CRLF) from 
the Line Termination Character drop-down list.

6. Do one of the following:
• Click Execute to run the process immediately.
• Select the Schedule tab to set up a schedule for the batch process. 

See Scheduling Batch Processes on page 24.

TSO Tax Amount (Output)

Run this procedure to generate a file containing the amount due by Accounts / 
Receivable Cycle for each taxpayer.

To run the TSO Tax Amount (Output) batch process:

1. Launch Govern.

2. Select Batch Processes > TSO Tax Amount (Output)*.
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*The name of the process and the path can vary according to the 
administrative setup in GNA.

3. Enter the TSO Number for which you want to generate the data or leave 
this file blank to generate a file with all TSO payments.

4. Select Extract Only Unpaid Accounts to add records only from accounts 
with a balance above zero. Deselect this checkbox to process all 
accounts.

5. Enter the Year or leave this field blank to generate data from all years.

6. Select the Cycle Code; this is a levy group; for example, school, county, 
district. You can leave this field blank to generate data from all cycles 
(Table: VT_USR_ARCYCLE).

7. Select Compute Late Charges to add the late charges to the file.

8. Select Print Balance Due to include the total amount owed for each 
account. Deselect this option to include only the amount billed. For 
example, if the balance can be paid installments, deselect this option. 
Select this option to print only the amount owed for the installment.

9. Select None, Carriage Return (CR) or Carriage Return / Line Feed (CRLF) 
from the Line Terminator Character drop-down list.

10. Do one of the following:
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• Click Execute to run the process immediately.
• Select the Schedule tab to set up a schedule for the batch process. 

See Scheduling Batch Processes on page 24.

TSO Batch Payment Generation

Run this procedure to import a file containing payment information by 
installment from the TSO to Govern.

To run this batch process:

1. Launch Govern.

2. Select Batch Processes > TSO Batch Payment Generation*.

*The name of the process and the path can vary according to the 
administrative setup in GNA.

3. Select the Installment for the payments; for example, first, second or third 
(Table: VT_USR_INSTALL).

4. Select the Line Terminator: None, Carriage Return (CR) or Carriage 
Return / Line Feed (CRLF)

5. Do one of the following:
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• Click Execute to run the process immediately.
• Select the Schedule tab to set up a schedule for the batch process. 

See Scheduling Batch Processes on page 24.

TSO File Layout

The TSO file is used to record the properties on which the taxes are paid by or 
through a financial service institution or tax service organization. 

1. The municipality sends the TSO file to the financial service institution or 
tax service organization (TSO).

2. The organization filters the file so that it contains only the properties for 
which they are paying taxes.

3. The organization fills in the amounts they are paying in the applicable 
installment field, first, second, third or fourth, and in the TSO Total Due 
field.

4. The organization returns the TSO file to the municipality with a check for 
the sum of the amounts in the TSO Total Due fields.

TSO File Layout 

Field 
Type / 
Length

Starting / 
Ending 
Position

Q R B P Comment
Standard 
Field

** Parameter for 
Effective Date

N

Action Code Char 1 1 / 1 M A = Add, C = Change, 
D = Delete

Y

TSO Number Char 3 2 / 4 M Y Y M Left justify, blank fill Y

Bank ID Char 12 5 / 16 M Y Y M Left justify, blank fill Y

Loan Number Char 30 17 / 46 M Y Y Left justify, blank fill Y

Tax Map Number Char 26 47 / 72 M Y Y Y Left justify, blank fill Y

Tax Year Char 4 73 / 76 Y Y Fiscal Year Y

Cycle Number Char 15 77 / 91 O Blank fill Y
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Bill Number Prefix Char 26 92 / 93 O Left justify, blank fill Y

Bill Number 
Sequence

Char 8 94 / 101 Y Left justify, blank fill Y

Barcode Number Char 8 102 / 109 Y M Left justify, blank fill Y

Item Number 
(Short Key)

Char 8 110 / 117 O O Blank fill Y

First Installment 
Amount

Char 12 118 / 129 Y M First Quarter Amount 
Being Paid or 0.00

Y

First Installment 
Code 

Char 1 130 / 130 Y “ “or “P” (P = Paid) Y

Second 
Installment 
Amount

Char 12 131 / 142 O Second Quarter 
Amount Being Paid or 
0.00

Y

Second 
Installment Code 

Char 1 143 /143 O “ “or “P” (P = Paid) Y

Third Installment 
Amount

Char 12 144 / 155 O Third Quarter Amount 
Being Paid or 0.00

Y

Third Installment 
Code 

Char 1 156 / 156 O “ “or “P” (P = Paid) Y

Fourth Installment 
Amount

Char 12 157 /168 O Fourth Quarter Amount 
Being Paid or 0.00

Y

Fourth Installment 
Code 

Char 1 169 / 169 O “ “or “P” (P = Paid) Y

TSO Total Due Char 12 170 / 181 Y M Total Amount being 
paid Left justify, blank 
fill

Y

Paper Bill Char 1 182 / 182 M Y Y = Yes, N = No Y

Receipt Request Char 1 183 / 183 Y Y = Yes, N = No Y

Delinquent Flag Char 1 184 / 184 Y Y = Yes, N = No Y

Arrears Flag Char 1 185 / 185 Y Y = Yes, N = No Y

Field 
Type / 
Length

Starting / 
Ending 
Position

Q R B P Comment
Standard 
Field
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*Notes: Logic is included to check for the Homeowner lock prior to changing 
the Mailing Index and to assign the Mortgage Company as the Mailing Index 
rather than the TSO when there is a matching CFHI #.

Owner Name Char 50 186 /235 Y Y Left justify, blank fill Y

Property Location Char 50 236 / 285 Y Y Left justify, blank fill Y

Municipality Code Char 3 286/288 M M PC_AREA.DIST_CITY N

First Net Tax Char 12 289/300 M M Balance on parcel 
minus Discount

N

First Gross Tax Char 12 301/312 M M Balance on parcel N

Penalty Amount Char 12 313/324 M M Penalty amount due N

Interest Amount Char 12 325/336 M M Interest amount due N

CFHI #* Char 5 337/341 O CFHI # of banked 
served by TSO

N

CR / LF Char 2 342/343 Optional Y

Legend

Symbol Definition

Q Bill Request (From TSO)

R Registration (To TSO)

B Tax Bills (To TSO)

P Payments (From TSO)

M Mandatory

Y Present

O Optional

Field 
Type / 
Length

Starting / 
Ending 
Position

Q R B P Comment
Standard 
Field
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Field Definitions

Field Definition

Char Character String

Numeric
May include spaces, left or right justified, no comma, and no 
decimal point

Currency May include spaces, decimal point optional, sign optional to the left
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Mailing Index
Update Owner Data in Mailing Index

Run this process to ensure that the Real Property Mailing Index is up to date 
with all the current owners. This process verifies the current mailing index. If 
the owner field contains the previous owner, it updates this with the current 
owner from the PC_OWNER table.

There are no parameters for this process.

To run the batch process

1. Launch Govern.

2. Open the Batch Processes explorer.

3. Select Update Owner in Mailing Index*.

*The path can vary according to the setup in GNA.

4. Do one of the following:
• Click Execute to run the process immediately.
• Click Schedule to create a schedule to run the process at a later date 

or on a regular basis. Refer to the Govern Batch Processing guide for 
details on scheduling batch processes.
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